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Foreword 

BGS Groundhog Desktop (Groundhog) is geological software developed by the British Geological 

Survey (BGS) for the display and editing of subsurface geological information. 

The software is available under the UK’s Open Government Licence.  

Please note – Groundhog Desktop does not provide access to BGS/NERC data, it is software only. 

Groundhog Desktop is intended as a basic GeoScientific Information System (GSIS*) – a software 

tool which facilitates the collation, display, filtering and editing of a range of data relevant to 

subsurface interpretation and modelling.  It has been developed by the Modelling Systems software 

development team, with help and advice being provided by Holger Kessler, Steve Thorpe, Ian 

Cooke, Rachel Dearden, Steve Mathers and Ricky Terrington. 

 

If you are new to Groundhog you may wish to jump right to the Quick Start Guide at Appendix 

A (at the end of this manual). 

 

 

 

BGS offers training, custom software development, integration services and geological 

consultancy services in relation to the use of the Groundhog Desktop software. For all enquiries 

please contact groundhog@bgs.ac.uk 

 

British Geological Survey 

Tel 0115 936 3143 Fax 0115 936 3276 

 

 

 

  

mailto:groundhog@bgs.ac.uk
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1 Overview 

BGS Groundhog Desktop (Groundhog) is geological software developed by the British 

Geological Survey (BGS) for the display and editing of subsurface geological information. 

1.1 QUICK START GUIDE 

If you want to get started right away, please refer to the Quick Start guide at Appendix 

A (at the end of this document). 

1.2 BGS GROUNDHOG DESKTOP GSIS 

BGS Groundhog Desktop GSIS (Desktop GeoScientific Information System - hereafter 

“Groundhog”) is a graphical software tool developed by the Geo-Analytics and Modelling 

Directorate of the British Geological Survey for the display of geological and geo-spatial 

information such as interpreted (correlated) geological cross-sections, maps and boreholes. 

The software is available under the UK’s Open Government Licence; 

http://www.nationalarchives.gov.uk/doc/open-government-licence/version/3/ 

This means the software is free to use, exploit and re-distribute for academic, personal, research 

or commercial purposes, subject to the terms of the UK’s Open Government Licence. We also 

require that you acknowledge the software in the following way wherever you use it to create 

or deliver any product, data, information or report; 

 BGS Groundhog® Desktop Copyright © BGS/NERC (year). 

For full details of the licensing and terms and conditions please refer to the license files in the 

installation directory. 

For any enquiries regarding Groundhog Desktop GSIS, please contact; 

groundhog@bgs.ac.uk  

 Capabilities 

Groundhog Desktop is intended as a basic GeoScientific Information System (GSIS*) – a 

software tool which facilitates the collation, display, filtering and editing of a range of data 

relevant to subsurface interpretation and modelling. You can use Groundhog to load and 

display certain types of borehole data, geological map linework, interpreted (correlated) cross-

section and faults. It also supports reference data such as elevation models and images and has 

basic editing capabilities. 

http://www.nationalarchives.gov.uk/doc/open-government-licence/version/3/
mailto:groundhog@bgs.ac.uk
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Typical view of Groundhog Desktop in use with map linework, cross-sections and boreholes 

loaded. 

 

1.2.1.1 MAP CAPABILITIES 

Groundhog can load and display geological map linework in terms of horizon BASE contacts 

(“croplines”). It can also present cross-section plan lines, fault trace linework, geo-registered 

map images and borehole positions. 

To open a blank map window use Session > Windows > New Map Window then click on the 

zoom to full extent button. 

1.2.1.2 CROSS-SECTION CAPABILITIES 

Groundhog can load and display interpreted (correlated) cross-section linework (horizon bases 

and fault sticks) and also display raster (image) backdrops which can be scaled interactively 

for digitizing. Basic borehole logs can also be displayed for correlation. 

Groundhog displays lines in cross-section by default. However, if correlation lines are correctly 

constructed by using line-to-line snapping (refer to cross-section reference later in this manual) 

then a coloured-up section can be constructed. 

 

Section with lines 
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Section with lines snapped together forming coloured-up polygons. 

 System Requirements 

 PC or laptop running Microsoft Windows OS, 

 2-button mouse with scrolling wheel. 

 Download and Installation 

Groundhog can be downloaded from  

http://www.bgs.ac.uk/research/environmentalModelling/groundhogDesktop.html 

  

To install, double click the setup.exe and follow the instructions in the installation wizard. 

NOTE: you may need administrator privileges to install the software, in which case please 

consult your system administrator or helpdesk. 

 Support and Warranty 

Groundhog Desktop is free-to-use software and comes with no support or warranty. Please 

refer to the licensing information within the installation folder for further details. We are happy 

to receive general enquiries regarding the software, but this does not constitute the offer of a 

helpdesk service. 

groundhog@bgs.ac.uk 

 

 

 

  

http://www.bgs.ac.uk/research/environmentalModelling/groundhogDesktop.html
mailto:groundhog@bgs.ac.uk
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2 The User Interface 

The user interface is divided into a series of panels. These panels can be undocked (split) if 

desired via Session > Windows > Dock/Undock All Windows. 

 

2.1 TOOLBAR 

The toolbar includes a conventional menu bar and a tabbed panel of buttons for loading, saving 

and manipulating data. 

2.2 MENUS 

1. Session – various load/save options for assembling a workspace session, 

2. Interoperability – various options for import/export of non-GDE-format proprietary and standardized 

data formats, 

3. Tools – various useful data tools, 

4. Geology – tools to predict and deduce geological information from workspace data objects, 

5. Help – about Groundhog Desktop. 

2.3 TOOLBAR TABS 

1. Home – workspace and data load/save buttons, 

2. Settings – capping layer and global property, 

3. Draw – editing and digitizing functions and settings, 

4. Calculate – prediction tools. 

2.4 WORKSPACE PANEL 

The workspace panel is a tabbed panel providing access to the data objects loaded into the 

workspace. It has the following tabs; 
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 Workspace 

This tab provides a categorized list of loaded data objects displayed in a hierarchical 

workspace object tree control. Depending on the category and the level of object in the object 

tree, various context-specific menus are available via right-click. 

 

Note that not all object types displayed in the tree are currently supported, and may vary 

across versions of the software. 

When you load a project its data objects will be added to this workspace object tree. To navigate 

the workspace object tree simply click on the + icons to expand each level of detail. Depending 

on the type of the object and the level of detail, various context-sensitive popup menus are 

available via right-click. 

 Codes 

This tab provides a reference list of geological rock layer codes referred to as the Coding 

Scheme, including some special codes such as “FAULT”. Picking a code from this list makes 

that code the active code for editing/digitizing. For details of how this list is created refer to the 

Dictionaries and Coding Scheme sections of this manual. 
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2.4.2.1 ADD CODE 

Allows a new rock layer code to be added to the list, together with an optional description. The 

new code will be retained for the duration of the session – to save it permanently, click Save 

Codes (see below). 

 

A corresponding colour can be chosen using the Choose button, as an alternative to typing in 

the RGB colour code.  In addition to adding the code, this also adds a colour to the legend. 

2.4.2.2 ADD COLOUR 

If only a new colour is needed, this option can be used. The new colour will be retained for the 

duration of the session – to save it permanently, click Save Colours (see below). 
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2.4.2.3 SAVE CODES 

The Save Codes button displays red text to indicate new code(s) have been added to the session, 

but not saved. Click Save Codes to save the new codes into the workspace permanently. 

 

 

Clicking this button saves all the codes loaded into the workspace back to the file from which 

they were loaded.  An information box confirms that this has taken place: 

 

 

The text on the Save Codes button now changes back to black. 
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2.4.2.4 SAVE COLOURS 

The Save Colours button displays red text to indicate new colour(s) have been added to the 

session, but not saved. Click Save Colours to save the new colours into the workspace 

permanently. 

2.4.2.5 ORNAMENTS 

Ornaments are just images which are used as fills in combination with the legend colours. 

Ornament fills are used in borehole logs and cross-sections, for example. Here is a typical 

ornament for SAND, in combination with a pale yellow legend colour, as seen in a borehole 

log template. 

 

An ornament is applied by loading a GIF, JPG/JPEG or PNG image file, which is named 

identically to the code name to which it applies, for example SAND.gif will be matched to the 

layer code SAND (names are not case-sensitive). GIF images with transparent backgrounds are 

optimal for ornaments because these allow a separate legend colour to show through in 

combination with the image. Groundhog ships with a basic set of ornaments for simple 

lithologies. Note that ornaments do not have to relate to lithologies, they can be used to 

represent any value from any field, as with the legend colours. The only restriction at the current 

version of Groundhog is that all ornament names must be unique. 

Ornament files are loaded when Groundhog starts from three separate folders in sequence, as 

follows: 

1. {Project folder}\ORNAMENTS\ – ornaments are taken by preference from this folder 

2. {Workspace folder}\ORNAMENTS\ – this is the 2nd folder which Groundhog wil search for ornaments 

3. {Install folder}\ORNAMENTS\ – this is the final area from which ornaments are loaded 

For example, if an ornament file named SAND.gif is placed in all three folders, the one in the 

project folder will be used preferentially. 

In addition, further ornaments can be imported during the session using the Interoperability - 

> Import - > Images – Ornaments Folder function.  See the relevant section of the manual for 

a description of this. 
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2.5 MAP PANEL 

The map panel is a container for any map windows you create. The map windows behave a 

little like tabbed windows in a web-browser. You can create as many map windows as you 

wish. For further details on map windows refer to the Map Window section of the manual. 

To open a blank map window use Session > Windows > New Map Window then click on the 

zoom to full extent button. 

2.6 CROSS-SECTION PANEL 

The cross-section panel is a container for any cross-section windows you create. The cross-

section windows behave a little like tabbed windows in a web-browser. You can create as many 

cross-section windows as you wish. For further details on cross-section windows refer to the 

Cross-Section Window section of this manual. 

2.7 WORKSPACES AND PROJECTS 

All data in Groundhog Desktop are held either in a Workspace or a Project. A Workspace is 

a high-level set of static reference data that may be common to many projects (e.g. DEM, 

national rock coding scheme). A Project is a set of individual data files that are actively being 

worked on (e.g. cross-sections, maps, boreholes). 

 Supported Data Types 

Groundhog currently supports (to varying degrees); 

 Dictionaries 

 Colour legends 

 Elevation grids (rasters) 

 Unstructured meshes (TINs) 

 Boreholes 

 Interpreted cross-sections (correlation linework and fault sticks) 

 Map linework (“croplines”) 

 Fault traces 

 Geological sequence tables 

 Images (including geo-registered images in map and section) 

 Web Map Services (WMS) 

 Shapes 

For more details on each, refer to the relevant sections below. 

For most of the above, Groundhog has its own XML-based data file format referred to as 

Geological Object Markup Language (*.goml). Generally it is not advisable to edit these data 

files manually – they are designed for data transfer and local project storage. XML schemas 

for some of the key objects are available on request via groundhog@bgs.ac.uk  

 Workspaces 

Groundhog workspaces are folders containing related collections of commonly used reference 

data. A single workspace may support several Groundhog projects by containing all of the 

common reference data for those projects, such as a national or regional rock coding scheme 

and a digital terrain model. 

mailto:groundhog@bgs.ac.uk


OR/15/046; Final 1.1  Last modified: 2017/07/17 09:31 

 13 

The default workspace is held in a folder called WORKSPACE_DEFAULT within the 

installation directory. Any reference data files included in this folder will be added to the 

default workspace. You can create your own workspaces by compiling the desired files in a 

folder of your choice and selecting this folder when Groundhog starts up by using the “+” 

button in the workspace selection dialog. The pull-down list contains a list of all previously 

loaded workspaces to choose from. 

 

 

Typical data resources include; 

 Dictionaries – usually at least a rock coding scheme, 

 A colour legend file, 

 Grids – e.g. a digital terrain model. 

Workspace data resources can be included in two ways; 

1. By physically placing the data file within the workspace folder, 

2. By adding a file path to the data file into the RESOURCES.txt file. 

The RESOURCES.txt file is a tab-separated file held within the workspace folder and 

comprising one data resource linkage per-line; 

DATA TYPE NAME PATH/URL EXTRA INFO 

GRID Terrain Model C:\Data\terrain.asc MODEL_CAP 

DICTIONARY London 
Formation Codes 

C:\Data\LondonCodes.godic  

WMS UK Geology Web 
Map Service 

http://...etc  

Note: RESOURCES.txt contains no headers. They are included above for clarity. 
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For GRID type objects, the extra info of “MODEL_CAP” sets that grid as the reference terrain 

model for the workspace. This can be changed interactively within the user interface if 

necessary. 

2.7.2.1 SPECIAL FILES 

These must, if used, be held within the workspace folder and be named exactly as shown here. 

LOCAL_GRID.txt - defines the gridding system used for the project i.e. the names of the 

highest level grid squares and their co-ordinates. 

 

 

BOUNDARY.shapes.goml – contains a list of co-ordinates that define the boundary area for 

the project, e.g. an outline map of a country, region, state or site. This file is read as Groundhog 

starts up and is then used as the workspace “boundary” object. Groundhog’s DEFAULT 

workspace has a basic UK coastline as it’s boundary shape. The workspace boundary can be 

switched on and off within each map window using the “boundary” checkbox. 

 

The format of the boundary file is the standard Groundhog shape format and comprises one or 

more <shape> elements, each with a series of coordinates forming a polygon. Note that the first 

and last coordinate of each polygon shape must match to close the polygon. 

<?xml version="1.0" encoding="UTF-8" standalone="no"?> 

<GeologicalObjects objecttype="SHAPE"> 

  <Shape name="My Workspace Boundary Shape"> 

    <Coordinates> 

      <coordinate x="300000" y="200000"/> 

      <coordinate x="301256.9" y="202365.5"/> 

      ... more coordinates as required 

      <coordinate x="300000" y="200000"/> 

    </Coordinates> 

  </Shape> 

</GeologicalObjects> 

Note that shapes can be imported from shapefiles (*.shp). Please refer to the shapefile import 

section of this manual for more details. 
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Shapes within the workspace can be interactively selected as the workspace boundary from the 

map window via right-click > Set As Workspace Boundary. 

 

2.7.2.2 DICTIONARIES 

A dictionary is simply a list of names with corresponding definitions (values). They are 

commonly used by Groundhog to look up descriptions of abbreviated or coded values, for 

example; 

SSG Sherwood Sandstone Group 

 

Cu Copper 

 

Dictionaries are held in XML format with a file extension of *.godic (Geological Object 

DICtionary). The format is as follows; 

<?xml version="1.0" encoding="UTF-8" standalone="no"?> 

<GeologicalObjects> 

  <dictionary name="Rock Codes" description="A list of rock codes"> 

    <dictionary_entry name="SST" value="Sandstone" /> 

    <dictionary_entry name="MDST" value="Mudstone" /> 

    <dictionary_entry name="LMST" value="Limestone" /> 

  </dictionary> 

</GeologicalObjects> 

Groundhog needs at least one dictionary which is referred to as the rock layer coding scheme 

(see next section). 
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Dictionaries can also be imported from a tab-separated text file where the first two columns of 

the file are the NAME and the VALUE. Further columns will simply be ignored. 

2.7.2.3 CODING SCHEME 

The coding scheme is a list of rock layer codes from which you can select for editing and 

digitizing. They are held as a Dictionary object. Groundhog ships with a pre-defined coding 

scheme based on the BGS Lexicon of Named Rock Units (http://www.bgs.ac.uk/lexicon/), but 

you can import your own codes from a tab-delimited text file (see Dictionaries), or create your 

own coding scheme dictionary file in the workspace 

(WORKSPACE_DEFAULT\CODING_SCHEME.godic). 

2.7.2.4 COLOUR LEGEND FILE 

Colours are held in a tab-separated text file called LEGEND.txt  in the workspace folder 

(WORKSPACE_DEFAULT\LEGEND.txt). You can add colours to the Groundhog workspace 

by adding to this file, or create your own file. The format is; 

CODE RED GREEN BLUE ORNAMENT IMAGE 

AAFS-AFSY 255 147 51 texture_library/a.jpg 

ABBR-BREC 255 117 84 texture_library/b.png 

ABBR-BRSS 255 117 84 C:\image.jpeg 

 

Colours are defined in the RGB colour model http://en.wikipedia.org/wiki/RGB_color_model 

where values for each colour are between 0 and 255. 

Both Coding and Colour Legend files can now be updated interactively from within 

Groundhog.  See the Workspace Panel section above for details on how to do this. 

2.7.2.5 ELEVATION GRIDS 

Groundhog supports regular grids for elevation models, for example a Digital Terrain Model. 

At least one grid to define the “model cap” (normally a terrain model) is required as this will 

be used to auto-generate profiles for the cross-section windows. 

Groundhog has its own binary format for grid data which enables it to maintain a permanent 

reference to a master terrain model and query the necessary elevations and profile as required 

– for example when a new cross-section is created or loaded. This format is a binary version 

of an ESRI-style ASCII grid file (http://en.wikipedia.org/wiki/Esri_grid) and is very efficient 

because you can have a regional or national DTM coverage registered with Groundhog without 

any computer memory issues. Groundhog will automatically query this data layer as necessary. 

Loading Grid Data 

ASCII grids (*.asc) can be imported via Interoperability > Import menu and will be 

automatically converted to the Groundhog binary format in the background. The object will be 

added to Reference Objects > Grid Coverages in the object tree. ASCII grids must have a 

header laid out in the following format; 

ncols 2000 

http://www.bgs.ac.uk/lexicon/
http://en.wikipedia.org/wiki/RGB_color_model
http://en.wikipedia.org/wiki/Esri_grid
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nrows 2500 

xllcorner 100000 

yllcorner 120000 

cellsize 25 

NO_DATA_VALUE -9999 

154.6 157.2 159.8 161.4 162.7 164.3 165.4……[DATA…etc] 

Groundhog will attempt to save a binary copy of the imported grid in the same folder as the 

ASCII file. If this is not possible (e.g. because the ASCII is in a read-only folder), Groundhog 

will instead save the binary file into the current workspace folder. If the grid is large the 

conversion process may take a few moments. 

To add a new binary grid to your workspace so that they are always available make sure to add 

a reference to it into the RESOURCES.txt file, otherwise you will need to re-load the grid each 

session. Use one line pre-grid entry. If you wish to set the grid as the default capping grid, 

append the term “MODEL_CAP” to the end of the row. Note that the values in the row are tab-

separated. E.g.; 

GRID   A Grid   C:\Data\Grid_1.obgrid   MODEL_CAP 

GRID   Another Grid   C:\Data\Grid_2.asc 

If you add an ASCII grid to the RESOURCE.txt file it will be automatically converted to 

binary. The next time the workspace is loaded Groundhog will automatically find the 

corresponding binary grid file for the ASCII listing, so there is no need to update the 

RESOURCE.txt file after the conversion process. 

2.7.2.6 IMAGES 

Groundhog supports JPEG and PNG format image files which can be loaded via Session > 

Load Reference Objects > Image. If the image has a world file it will be automatically detected 

and the image can then be displayed in a map window in the correct geographic location (geo-

registered). Note that Groundhog does not support rotated images. 

Loaded images can be geo-registered using the map window.  This creates an ESRI format 

world file, which is compatible with other GIS applications.  Refer to the Map Window section 

of this manual for further details. 

Loaded images can also be registered into a cross-section window interactively. This is 

particularly useful when digitizing. Refer to the Cross-Section Window section of this manual 

for further details. 

2.7.2.7 WEB MAP SERVICES 

Groundhog is a rudimentary WMS client, allowing certain BGS-published WMS services to 

be displayed in the map window(s). The URL to the WMS should be included in the workspace 

RESOURCES.txt file, e.g.; 

WMS BGS_Detailed_Geology https://map.bgs.ac.uk/arcgis/services/BGS_Detailed_Geology/MapServer/WMSServer 

Loaded WMS services will be added to the Reference Objects > Web Map Services folder in 

the workspace object tree. The default workspace of Groundhog comes with a link to the BGS 

digital geological map as a WMS so this should automatically appear in the tree. 

To display the WMS in the map window, right-click (on the WMS layer of interest) > View 

WMS Layer In Map. 

https://map.bgs.ac.uk/arcgis/services/BGS_Detailed_Geology/MapServer/WMSServer
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Note that Groundhog has no capability for Latitude/Longitude, so can only support WMS 

services which can respond to requests in a cartesian grid coordinate system (e.g. British 

National Grid). 

 Projects 

Projects are what you normally work with day-to-day to load and save the data you are working 

on. Project data is held in XML data files. For this, Groundhog has its own XML-based data 

file format referred to as Geological Object Markup Language (*.goml). Generally it is not 

advisable to edit these data files manually – they are designed for data transfer and local project 

storage. 

Each GOML file contains objects of a single type, for example boreholes or cross-sections. 

When data is saved out as a Groundhog project a Geological Object Project  file (*.GOP) and 

a series of GOML files is created, one per object type; 

 Project1.gop 

 Project1.cross-sections.goml 

 Project1.boreholes.goml 

 Project1.faults.goml 

 Project1.croplines.goml 

Note the naming convention. The first part of the file name is the name of the project, and the 

second part (shown in bold above) is the data type. Never re-name files manually because 

Groundhog relies on this naming convention to find all linked data files. 

To load a project, simply pick the .gop file via Session > Load Project or click on the load 

button in the toolbar data tab. 
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All GOML files associated with the project will be automatically loaded. To load GOML data 

files individually use Session > Load Geological Objects > From GO File menu. Data in other 

formats can often be imported and exported via the Interoperability menu (see the 

Interoperability section of this manual for further detail). Certain reference data can be loaded 

via Session > Load Reference Objects. 

To save a project use Session > Save Project or click on the save button in the toolbar data tab. 

 

When saving a project, if you retain the existing project file name when you press save the 

previous versions of the data files will be over-written. 

You are strongly advised to save your work regularly. Do not wait until the 

end of the day to save all of your work. You are also strongly advised to 

increment the project name from time-to-time to ensure you have a series of 

project backups should the saved-out data become corrupted, e.g. 

 Project1_v1.gop 

 Project1_v2.gop 

 … 

 Project1_vn.gop 

Project data files are generally quite small, so keeping a series of backups should not present 

any data volume issues and superfluous backups can be deleted manually if desired. 
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3 Map Window 

Map windows can be created either by sending existing loaded objects to them or by creating 

a new blank window. 

To open a blank map window use Session > Windows > New Map Window then click on the 

zoom to full extent button. 

At the current time there is no undo/redo capability on map objects – this function is still 

in development. 

3.1 VIEWING OBJECTS 

Many objects in the object tree can be viewed in map windows via right click > View 

[object(s)] in Map Window. This opens a sub-menu where you can either create a new map 

window or select an existing map window. 

3.2 ZOOMING AND PANNING 

Panning in the map window is achieved by holding down the left mouse button and dragging 

in the relevant direction. 

Zooming in and out can be done by either: 

(1) Using the mouse wheel, or 

(2) Using the and  buttons on the toolbar to incrementally zoom in or out. 

To zoom to the full extent of the window use the button   

 

When you zoom in and out using the mouse wheel the reference point for the zoom will re-

focus on the mouse cursor position, making it very easy to zoom in to an exact point of interest 

very quickly. 

 

3.3 CROSS-SECTIONS 

Cross-sections can be viewed as a line-of-section in the map window. Hold down the SHIFT 

key and hover over the line to peek into the geology of the cross-section at that position – the 

data will be presented as a log image. 

 Opening In Cross-Section Window 

To view a cross-section in the section window from the map window, right-click on the 

displayed cross-section in the map window and select View Cross-section: 
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The selected cross-section will then be displayed within a new cross-section window. 

 Drawing A New Cross-Section 

To draw a new cross-section: 

(1) Select the Create New Cross-Section button from the map window toolbar.   

(2) Specify a name for the new cross-section. 

 

A message will appear explaining how to being construction. 

 

 

(3) In the map window the mouse cursor changes to  to signifiy construction mode. Start to draw the new 

cross-section using single mouse clicks within the map window to create the nodes of the line-of-section. 

If you have boreholes displayed in the map window these will be previewed if you hover over them – if 
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you then click directly on the borehole position it will be added to the cross-section as a borehole object. If 

you want to add a point at or very close to a borehole but you don’t want to add the borehole itself to the 

cross-section, hold the CTRL key to add the position as a plain coordinate. If you click a position that is not 

a borehole position it will be added as a plain coordinate. If you wish to edit the coordinate X and Y values, 

hold down the CTRL key before clicking – this will display an edit dialog. 

 

 
 

(4) To finish drawing the cross-section, once the final desired point of the line-of-section has been placed, 

select the Finish Cross-Section button from the map window toolbar. 

 Editing An Existing Cross-Section In The Map 

You can edit the alignment of an existing cross-section, either by extending at either end, or by 

inserting new positions into the middle of the cross-section. 

IMPORTANT: Although it is technically possible to extend a section at either end once you 

have already started to work on it, it is strongly advised that all map cross-section alignment 

work is completed before drawing any correlation linework into the section plane itself to avoid 

any unexpected changes to your linework that could be caused by changing the alignment. 

To extend the cross-section in either direction, right-click near to the end that you wish to 

extend from, and choose Extend Cross-Section. Next, single-click in the map at the location 

you wish to extend the cross-section to. 

To insert a new position in the middle of the cross-section, right-click anywhere along the 

cross-section and select Insert New Position Into Cross-Section. Next, single-click in the map 

at the location you wish to be added to the alignment. Note that this option is only available if 

the cross-section has not been correlated – if correlation linework already exists, the option will 

be greyed-out. 

3.4 CROPLINES 

Croplines are effectively the geological map. Lines should always represent the BASE contact 

of the geological layer. Croplines can be at surface (outcrop) and/or sub-surface (subcrop), 

therefore the complete set of croplines for a given geological area will be a full sub-surface 

map of the BASE contacts of all of the geological horizons. 

Croplines only represent true contacts – they should not be used to draw project boundaries to 

constrain horizon coverages. 

Croplines are, by default, the representation of the BASE contact of the unit against the ground 

surface in the case of outcrop linework or against the base of an overlying horizon in the case 

of subcrop. However, in faulted geology a cropline may represent a contact of the BASE of the 

horizon with the fault plane. For further detail refer to the Workflows > Fault Construction 

section of the manual. 
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 Drawing A New Cropline 

To draw a new cropline: 

(1) First select the desired rock layer code from the Rock Code Library.  This will set the code as the currently 

active drawing code in the session. To do this, select the Codes tab from the left hand object reference 

window taskbar and scroll or search for the geological code: 

 
 

Or, select the Recent button to display a list of recently used codes to select from. 

 

If your desired code does not exist, click on Add Code and enter the rock code name manually. 

 

Alternatively, select the DRAW tab from the main taskbar to display the drawing ‘ribbon’ and select a rock 

code from the Recent Codes area: 

 

 
 

Once selected the active rock code will be displayed in the map window toolbar as a label and a coloured 

box: 



OR/15/046; Final 1.1  Last modified: 2017/07/17 09:31 

 24 

 

 
 

Another way to set the active rock code is to pick the code up from an existing piece of linework. To do 

this, hold down CTRL and move the mouse across the line – the rock code will be picked up and set as the 

active code. 

 

(2) To start drawing a new cropline, select one of the two drawing tools in the map window toolbar: 

 
 

The left hand pen tool allows you to draw a new line by holding down the left mouse button and dragging 

the pen across the map window to trace the new cropline until the mouse button is released.  Nodes are 

added automatically, the density of which can be adjusted in the DRAW ribbon by using the slider marked 

‘Pen tool node density’.  The line can subsequently be smoothed once drawn using the ‘Vertex Edit 

Smoothing’ slider in the DRAW ribbon and moving the nodes around. 

 

The right hand digitizing tool allows you to draw the line one node at a time, giving greater control over 

node positioning along the line.  Use where positioning of nodes is more critical.  Single-click to add nodes 

to the line and double-click to finish the line. Again, smoothing is possible by later editing. 

 

(3) Once finished drawing, click the selected pen tool again to turn drawing mode off, or leave the pen active 

to continue to draw another cropline. 

 

 Editing A Cropline 

To edit a cropline you must first make the line active by clicking on it with the left mouse 

button.  The nodes are then displayed as shown below (cyan colour).  Nodes can then be moved 

individual as appropriate or with the option to smooth the line to different levels using the slider 

‘Vertex Edit Smoothing’ in the DRAW ribbon. The smoothing has the effect of causing nodes 

adjacent to the one being dragged to also follow the direction of the mouse cursor. 
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New nodes can be added by double clicking at the appropriate position along the active line. 

Double clicking on an individual node in an active line will remove the node from the line. 

To delete a whole line, right mouse click on the line and select Delete Line.  A dialogue will 

appear asking for confirmation.  Select yes to delete the line. 

 

3.4.2.1 SPLITTING A CROPLINE 

To split a cropline at a particular position, right mouse click on the line at the appropriate point 

where you wish to split the line and select Split Line.  This will break the original cropline at 

the point of the right mouse click creating two separate lines. 
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3.4.2.2 CUTTING CROPLINES 

To cut a cropline or a set of croplines, first draw a shape.  This can be either a line or a polygon 

and is drawn by setting the current code to Shape and selecting a pen tool: 



OR/15/046; Final 1.1  Last modified: 2017/07/17 09:31 

 27 

 

After drawing the shape across the croplines to be split, right click on the shape and select Use 

Shape As Cutting Path: 
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A dialogue box asks which lines are to be cut: 

 

If the shape that has been drawn is a polygon, a further dialogue box asks: 

 

All croplines and or cross sections which are intersected by the shape are now cut into two 

lines.  If the option to discard lines has been chosen, these segments of the lines are removed 

from the workspace. 
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This is most useful when you need to cut several croplines along the same cut path, for example 

to introduce a fault trace. 

 Joining Croplines 

Two Croplines can be joined by dragging the end of one of the lines towards the end of the 

other line. When the two ends are brought close together the two lines will be joined. It is 

important to understand the way in which Cropline joins behave, depending on the properties 

of the line objects. 

In general, the line you are editing (active line) will be merged into the line you connect it to. 

The merge process will attempt to preserve as much attribution as possible, but the attribution 

on the line you connect to will sometimes be given priority, for example if you join two lines 

with conflicting presence side attribution, the merged version of the line will adopt the side 

attribution from the line you connect the active line to. 

   
Joining Simple Lines – lines are merged 

   

Joining Lines With Side Attribution – lines are merged, attribution is retained 

   

Joining lines with differing fault crop attribution – lines are snapped 

 

If only one of the lines has side attribution, then the merged line will adopt that side value, 

regardless of whether the attribute is on the active line, or the line being connected to. 

If both of the lines have a fault crop attribute, the merged line will also be flagged as a fault 

crop. 

If only one of the lines has a fault crop attribute the lines will only be JOINED – they will not 

be merged into a single line, and will remain as two separate line objects snapped together. 

This is to allow the distinction between the two types of crop. 

 Seeding Layer Presence Side On Croplines 

A basic cropline defines the base contact of a geological layer on the map, but it does not 

specify on which side of the line is the “presence” of that layer (i.e. to the left or right of the 

line). Because Groundhog deals with true contact lines rather than coverage polygons (a.k.a 

envelopes), the presence is attached via a SIDE attribute. The value of this SIDE attribute is 

either LEFT or RIGHT (or null if the side is not known). There are two ways to attach the SIDE 
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attribute to the linework, interactively or automatically. The SIDE attribution is preserved in 

the project data files when the project is saved. 

3.4.4.1 ATTACHING A SIDE ATTRIBUTE INTERACTIVELY 

The SIDE attribute can be placed interactively in the map window by first making the line 

active, then picking the side tool and clicking on the map to the desired side of the line. Note 

that the side attribution tool is only active when a Cropline object is selected. Small side ticks 

appears graphically to show which side the attribute has been placed. 

 

 

 

3.4.4.2 ATTACHING A SIDE ATTRIBUTE AUTOMATICALLY 

If you have correlated cross-sections in the workspace you can automate the side seeding 

process – Groundhog will attempt to use the correlation lines from the cross-sections to detect 

which side of the croplines are the presence of each layer. If the correlation linework agrees 
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with the croplines (i.e. is snapped to or very close to the cropline positions) then the side 

attribute will be attached to the linework. 

Either choose Geology > Predict Cropline Presence Side from the main menu, or click on the 

Predict Sides button in the calculate tab in the main toolbar ribbon. 

 

A dialog appears. If you choose “Overwrite all information” the automated process will 

overwrite any pre-existing SIDE attribution on the croplines, if you choose “Retain any existing 

information” the automated process will only attempt to attach SIDE attribution to cropline 

that do not currently have a value for that attribute. 
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Raw Linework Before Automated 
Prediction 

 

Linework Displaying Ticks Following 
Automated Prediction. The small ellipses 
show the seed positions that were used 
from the cross-sections. 

Any linework that is not attributed as part of this process suggests either a lack of correlation 

of that horizon in any cross-section passing through that line, or rough correlation that is not 

close enough to the cropline position in the sections to be detected – snapping of linework 

within cross-section would resolve this. Otherwise, simply place the SIDE attribute manually 

as described earlier. 

3.5 BOREHOLES 

 Entering Borehole Data Interactively 

You can create individual boreholes and borehole logs interactively. First arrange a map 

window to show the area where you wish to place the borehole, then right-click either exactly 

where you want to place the borehole, or in a suitable blank area of the map if you wish to type 

the coordinates in. Select Create Borehole from the popup menu. 

 

A coordinate position entry dialog will appear pre-populated with the map coordinates of the 

mouse click. Edit the coordinates as desired and click OK. 

 

A borehole data entry dialog will appear. Here you can type a name for the borehole and set an 

identifier if you have one. The X, Y co-ordinates can be adjusted. You can also enter a collar 
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height, or click on Set from Model Cap to extract a value from the current terrain elevation 

grid. Click OK. 

 

The borehole will be added to the map window, and will also be added to the default borehole 

dataset folder in the object tree. If the borehole is the only object in the map window, you may 

need to zoom to full extent to see it. 

To edit the above collar information at any time, or to edit the collar information for an existing 

loaded borehole, simply right-click on it either in the map or in the entry in the object tree and 

select Edit Borehole. 

 

Next you can attach a log to the borehole position. Right-click on the borehole in the map or in 

the object tree and select Create New Log. 
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A dialog box requests a name for the new log. 

 

A dummy log is created coded as 1m of “SAND”. For details of how to edit logs refer to the 

Log View chapter of this document. 

 Importing Boreholes Into The Map 

Refer to the Interoperability, Import section of the manual for details on loading borehole data 

from a spreadsheet. Once the borehole data has been loaded, it can be found under Geological 

Objects > Boreholes. 

To display in the map window, expand the borehole tab in the data tree and right mouse click 

on the borehole dataset to select View all boreholes in map window… 
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If borehole interpretations are attached to a borehole, it is also possible to display a quick view 

of the attached interpretation(s) within the map window by holding down the SHIFT key and 

hovering over the borehole: 

 

When you save the session to a project file the borehole data will be included. 

 

3.6 FAULTS(FAULT TRACES) 

To draw a new fault line: 

(1) First select the Codes tab from the left hand object reference window taskbar and select Fault from the 

Lines area at the bottom of the window: 
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This will then be displayed in the map window toolbar: 
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(2) To start drawing a new fault line, select one of the two pen tools in the map window toolbar: 

 
 

Drawing and editing is then the same as for Croplines – please refer to the earlier section on Croplines for 

further detail on basic linework editing techniques. 

 

 Naming Faults 

You can specify the name of a fault via right-click > Re-Name Fault on the fault object in the 

object tree. 

 

 

You will be given the option to also name any fault sticks in the cross-sections that are attached 

to this fault trace on the map. 

 

 

 Splitting Croplines Using Faults 

To split any croplines that intersect with a fault line, right mouse click on the fault line and 

select Split intersecting croplines.  This will display a dialog listing all the croplines that 

intersect the fault line allowing you to choose which lines to split: 
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Depending on the nature of the fault and whether it comes to the ground surface you may want 

to only choose a subset of Cropline rock codes to split with the fault. Once selected, click OK 

and the corresponding croplines will be split at the point where they intersect the fault line: 

 

 Flagging Fault Traces At Surface/Subsurface 

Digitized fault trace lines in the map do not have to be at the ground surface. To make this clear 

you can set a flag on the linework via right-click > Tools > Flag As ‘In Subsurface’|’At 

Surface’. The icon and linework graphic changes in the object tree and in the map window 

respectively to a dashed line. 

 

3.7 STRUCTURAL MEASUREMENTS (DIP/AZIMUTH) 

 Import 

Basic dip/azimuth measurements can be imported from a spreadsheet. 

Interoperability > Import > ASCII/Text Files (Generic) > Dip/Azimuth Structural Point 

Data 

The importer accepts a space or tab-delimited text file with no header and 4x numeric columns 

(easting, northing, azimith, dip). Each row in the file is a single measurement. Here is an 

example with three measurement records. 



OR/15/046; Final 1.1  Last modified: 2017/07/17 09:31 

 39 

134202 406049 146 4 

144667 405043 56 16 

187254 414556 234 56 

 Create 

Structural measurements can be entered manually via a map window. Simply right-click at the 

desired location in an open map window and choose Create > Dip/Azimuth. 

 
Contains OS data © Crown Copyright and database right 2015-16 

A coordinate dialog allows fine-tuning of the position. 

 

Enter a dip value. 

 

Enter an azimuth value. 

 

A measurement appears in the map. 
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Contains OS data © Crown Copyright and database right 2015-16 

 Edit 

 

Imported or manually-created measurements appear under Geological Objects > Dip and 

Azimuth Measurements in the object tree in the left-hand panel. 

 
Contains OS data © Crown Copyright and database right 2015-16 

The dip and azimuth values can be edited from the tree via right-click > Tools > Set 

Dip/Azimuth. 

 Structural Contour Tool 

You can use structural measurements to calculate and display predicted contours in map and 

cross-section. To enable contours, in the map, right-click (on a measurement) > Show 

Contours. Enter a vertical tolerance value (metres) for the contour map. A tolerance value of 

1m will highlight positions in the map that lie within 1m of the true contour as projected across 

the map from the structural measurement point. Generally, smaller tolerances can be used in 

areas of low relief. In mountainous regions, higher tolerances (tens of metres) are needed to 

produce a usable contour on the map owing to the steep gradients. 
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The contour map is re-calculated each time map is refreshed. This may lead  to a slight delay 

in map refresh. The contour will also be automatically projected into the cross-section windows 

as a red line. 

 
Contains OS data © Crown Copyright and database right 2015-16 

A legend shows the variation in height from the exact contour plane, up to the limit set in the 

tolerance dialog box. Red markers in the map are closer to the real contour plane than blue 

markers. The presented map is a grid-sampled (raster-style) map as-per BGS SIGMA and 

references whatever elevation grid is currently set as the Model Cap in the main SETTINGS 

tab. 

In the example above you can see where the contour plane intersects the terrain profile at 

positions a, b and c. 

To switch the contour map off, right-click on the measurement in the map and choose Hide 

Contours. 

The contour tool can also be used to look at flood risk, or to look at likely river terrace 

distribution. To do this, create a new measurement somewhere on a floodplain or at the river 

with dip = 0 and azimuth = 0. Below is an example of such a value set with a 3m tolerance 

close to the River Trent at Burton-on-Trent. 
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Contains OS data © Crown Copyright and database right 2015-16 

 

3.8 DISPLAY CORRELATED EXTENTS 

With cross-sections visible in the map window it is possible to see the spatial distribution of 

the correlation of a particular rock unit. This is achieved simply by setting the active rock code 

– when this happens its map distribution in cross-section will appear as thick coloured lines 

along the lines-of-section. The active rock code can be set from the Codes tab, from the Recent 

Codes panel of the DRAW ribbon, or by picking up a code from a piece of linework by holding 

CTRL and hovering the mouse over the line; 
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Map showing distribution of an orange-coloured rock unit “alne” in cross-sections 
towards the north of the project. 

A nice feature of this function is that you can quickly see the relative distribution of layers 

across a project by displaying a representative cross-section in a cross-section window, holding 

CTRL, and dragging the mouse across the section vertically to pick up each code in the 

geological sequence one after the other. The map will respond by displaying the distribution of 

each code as you scroll across the section with the mouse. 

3.9 SHOWING/HIDING MAP WINDOW OBJECTS 

On the right hand side of each map window is the map contents panel: 

 

When a new object is added to the map window it will also be inserted under the relevant object 

type listed on the Objects tab.  Expanding out each object type heading by clicking on the 

arrow located on the left hand side of the object label allows you to see what is currently loaded 

into the map window.  From here it is also possible to turn the visibility of objects within the 

map window on/off.  To show or hide all objects of a particular type, check or uncheck the 

Show/hide all checkbox. 
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3.10 MAP WINDOW SETTINGS 

The settings for the map window can be viewed and changed by clicking on the Settings tab 

of the map contents panel located on the right hand side of the map window: 

 

 Elevations 

Ticking the checkbox labelled Show Elevations will display the elevation from the loaded 

DTM(s) in the lower left corner status bar of the map window for the mouse cursor location as 

it passes over the map window: 

 

Unticking the checkbox will return to displaying only the x and y coordinates in the lower left 

corner of the map window. 

 Simplified Croplines 

Ticking the checkbox labelled Show Simplified Croplines will graphically simplify any 

croplines displayed in the map window using a distance tolerance of 50 to remove nodes from 
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the line. It is useful when working with large detailed projects as it speeds navigation by making 

the map window more responsive; 

  

To display the simplified croplines after ticking the checkbox, move the mouse cursor over the 

map window in order to force the window to refresh. 

Ticking the checkbox only removes nodes for graphical display.  All original nodes are retained 

on the cropline object.  Unticking the checkbox will return to displaying all the original nodes.  

Again, once you have unticked the checkbox, move the mouse cursor over the map window in 

order for the window to refresh. 

NOTE: This feature should be disabled when editing linework 

 Background Colour 

This option allows the background colour to be specified using the Select Colour dialog.
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After choosing a background colour, the map window is displayed with this colour as the 

background: 

 

3.11 ACCESSING UK TOPOGRAPHIC BASEMAPS 

Having access to topographic basemaps in the map window can be very useful. UK basemaps 

of some OS Open Data products are made available in Groundhog via a set of free web services 

hosted by ESRI. 

 
Contains OS data © Crown Copyright and database right 2015 

http://www.esriuk.com/content-services/online-content-services/free-services 

These data are available for free under the terms of the Open Government License 

http://www.nationalarchives.gov.uk/doc/open-government-licence/version/3/ 

https://www.ordnancesurvey.co.uk/business-and-government/products/opendata-

products.html 

http://www.esriuk.com/content-services/online-content-services/free-services
http://www.nationalarchives.gov.uk/doc/open-government-licence/version/3/
https://www.ordnancesurvey.co.uk/business-and-government/products/opendata-products.html
https://www.ordnancesurvey.co.uk/business-and-government/products/opendata-products.html
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The OS_Open_Carto_2 is a good general basemap to use, and has around 17 levels of detail as 

you zoom in, right down to street level. 

 Configuring Basemaps 

The free data services are served by ESRI as map tiles and are configured in Groundhog by 

adding an entry to your workspace RESOURCES.txt folder. The WORKSPACE_DEFAULT 

standard workspace comes pre-configured with key basemaps. 

To configure a basemap tile server, add a tab-separated line like the following into 

RESOURCE.txt in your chosen workspace folder. For more information on Groundhog 

workspaces, please consult the relevant section of this user manual. 

MAP_TILE_SERVER Layer Name Tile service URL Service definition 
URL 

e.g. 

MAP_TILE_SERVER    My_Basemap    http://domain.eg/server/tiles/   http://domain.eg/server/definition.json 

At the time of writing, the main basemap, OS Open Carto 2, has the following URLs for the 

tile server and the JSON definition, respectively; 

http://tiles1.arcgis.com/tiles/qHLhLQrcvEnxjtPr/arcgis/rest/services/OS_Open_Carto_2/MapServer/tile/ 

http://tiles1.arcgis.com/tiles/qHLhLQrcvEnxjtPr/arcgis/rest/services/OS_Open_Carto_2/MapServer?f=pjson 

The Layer Name field is free text. 

When Groundhog starts up it will read the MAP_TILE_SERVER entries and attempt to 

configure each layer. 

 Working With Basemaps 

Assuming Groundhog was able to configure the layer(s) at start-up, then appear listed in the 

Settings tab. 

 

The label in this list will be the label specified in the RESOURCE.txt file. By default, “NONE” 

is selected, so you need to actively choose a basemap layer before it will appear in any of your 

map windows. 

As soon as you choose a basemap from the list, the map tiles will load into your map window(s) 

on-the-fly as soon as you being navigate (pan or zoom). For any given map view, several tiles 

will be loaded and displayed to cover the visible extent. This process is not perfect, so you may 

occasionally see missing borders. 

http://domain.eg/server/tiles/
http://domain.eg/server/definition.json
http://tiles1.arcgis.com/tiles/qHLhLQrcvEnxjtPr/arcgis/rest/services/OS_Open_Carto_2/MapServer/tile/
http://tiles1.arcgis.com/tiles/qHLhLQrcvEnxjtPr/arcgis/rest/services/OS_Open_Carto_2/MapServer?f=pjson
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Set the transparency of the basemap layer using the slider control in the settings panel of each 

map window. 

 
Contains OS data © Crown Copyright and database right 2015 

As you start to work with basemaps, you should be aware of the session and disk caching 

mechanism. Groundhog uses the following protocol; 

Groundhog has both a session and a disk cache of map tiles. As each tile is requested by the 

map window, Groundhog first looks in the session cache (i.e. computer memory) to see if the 

tile has already been loaded. If the tile has not previously been loaded in the session, Groundhog 

will then check the local disk cache for a copy of the tile image. If the tile cannot be found on 

disk, Groundhog will make a request to the ESRI web service and will download the tile. 

When new tiles are downloaded they are simultaneously copied to both the session and disk 

caches for later use. When Groundhog is closed down, the session cache is destroyed, but the 

disk cache remains. The disk cache is held in a folder called MAP_TILE_CACHE within 

your Groundhog workspace folder. Within that folder are individual sub-folders, one per tile 

service. The disk cache will continue to fill up indefinitely across multiple sessions, so be aware 

these folders can potentially become quite large over time. 

In cases where Groundhog has the tile(s) in the session cache, navigating will be quite rapid. 

In cases where tile(s) come from the disk cache there may be a slight delay as the tiles are 

copied from the disk to the session cache. In the final case where the tile(s) must be freshly 

downloaded from the web server, the response will slow down noticeably as Groundhog waits 

for the images to download. Please be patient when navigating in these cases, especially when 

zooming into new areas where there is no available disk cache. 

 Using The Disk Cache 

The disk cache serves two purposes; 

1) To improve performance when dynamically loading new tiles as you pan and zoom, 

2) To allow basemaps to be still displayed when there is no internet connection, or when the ESRI data 

service is not responding. 

For extra performance, even if you have an internet connection, you can either switch the 

basemap off completely by selecting “NONE” from the pull-down list, or use the “Cache 

Only” checkbox in the settings panel. When this box is checked, Groundhog will stop making 
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web requests for new tiles, and will only display those which are already in either session or 

disk cache. This significantly improves map navigation performance, so it can be a useful way 

to zoom into an area of interest before un-checking the box to start downloading again at a 

greater level of detail. 

If you need to work offline, first pre-prepare your area of interest by zooming into it and 

panning around to fetch all necessary tiles from the server at the level of detail you need. These 

will be copied automatically to the disk cache for later use. Groundhog also automatically takes 

a copy of the tile server definition file into the cache (“DEFINITION.json”) in case the 

definition cannot be fetched from the ESRI server. This means you can still work without an 

internet connection, and Groundhog will display any tiles available in the disk cache. 

If the cache folders become too large, you can clear the entire cache for any basemap layer by 

clicking on Clear Cache in the Setting tab. If the basemap behaves erratically or causes errors, 

try clearing the cache to see if this resolves the problem. 

3.12 IMAGES IN THE MAP 

Images in the map window can be moved and resized. For further details, please refer to the 

main Images section later in this manual. 
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4 Cross-Section Window 

Cross-section windows display individual cross-section objects. You can open as many as you 

like, and even open the same cross-section in two separate windows. 

4.1 ZOOMING AND PANNING 

Panning is achieved by a single left mouse click and drag in the relevant direction. 

Zooming in and out can be done by either: 

1) using the mouse wheel (given you have a mouse with a wheel), or 

2) using the + and – buttons on the toolbar . Here pressing minus will zoom out, but pressing the plus 

button works differently; it allows you to draw a bounding rectangle (marquee) by click and drag 

which then auto zooms in to that area. 

To zoom to the full extent of the window use the button  . 

The mouse wheel zoom is programmed to re-focus on the current mouse cursor position which 

makes zooming into a point of interest very quick and easy. 

4.2 VERTICAL EXAGGERATION 

To adjust exaggeration in the vertical axis use the drop down list as shown below. Type in 

specific values and hit ENTER key if they do not exist in the default list. 

 

Adjust until you reach a comfortable level according to the vertical depth range of the 

stratigraphic units. 

4.3 UNDO/REDO 

The cross-section window supports a rudimentary level of undo/redo capability, although this 

is still in development it should be enough to get out of most problems. To undo or redo any 

changes made use the Undo/Redo buttons on the right hand side of the taskbar. 
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4.4 DRAWING CORRELATION LINES 

To start drawing, choose the DRAW option from the main taskbar giving you the drawing 

‘ribbon’. Then choose the type of geological line you wish to draw either by selecting from the 

‘Codes’ tab in the left hand object reference tree, by selecting from the Recent Codes panel in 

the DRAW ribbon, or by holding CTRL and dragging the mouse across an existing line to pick 

up its code. 

1. For correlation lines representing the bases of units, choose the relevant Lithostratigraphy/Lithology 

combined code from the Rock code library. This will then appear in the (currently) blank text box in the 

section window taskbar, indicating the labelling for the current working line. 

2. For all other types of geological object, Fault, Profile or Shape, choose from the ‘Lines’ option at the 

bottom of the Code tab in the object tree. 

2.1. Fault. Draw a line representing a fault stick. 

2.2. Profile. Draw a terrain profile. Note here that a DTM will normally be available and a profile will be 

loaded automatically. If not available draw from scratch by choosing profile and drawing line. If is 

available you can delete the pre-loaded line and draw your own. 

2.3. Shape. Draw an irregular shape such as a lens or sketch over an image etc. This feature is intended 

for rough sketching in a separate “layer”, with the idea that geological attribution could be added 

later on, although this feature is still in development. 

 

To draw a new line between points of reference click on one of the two pen tools in the section 

window taskbar as shown below. 

 

The left hand pen tool allows you to draw a new line by holding the left mouse button down 

and dragging the pen across the section window until the mouse button is released. Nodes are 

added automatically, the density of which can be adjusted in the DRAW ribbon by using the 

slider marked ‘Pen tool node density’. Note that the line can subsequently be smoothed once 

drawn using the ‘Vertex edit smoothing’ slider in the DRAW ribbon and moving the nodes 

around. 

The right hand digitizing tool allows you to draw the line one node at a time, giving greater 

control over node positioning along the line. Use where positioning of nodes is more critical. 

Again smoothing is possible by later editing. 
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4.5 EDITING LINES 

To edit a line you must first make the line active by clicking on it with the left mouse button. 

The nodes are then displayed as shown below, and the line itself will appear green. Nodes can 

then be moved as appropriate with the option to smooth the line to different levels using the 

slider ‘Vertex Edit Smoothing’ in the DRAW ribbon. Line end nodes can be snapped by 

dragging a node to another (snap enabled) line such as another correlation line (see under 

snapping in next section). 

New nodes can be added by double clicking at the appropriate position along the line. 

 

To remove a node double click that node. To add a node double click anywhere on the line 

outside existing ones. 

To delete a whole line right mouse click on the line and a dialogue box will appear for 

confirmation. Choose yes and the line is deleted. 

To move a whole line position place mouse arrow over the line, hold down the shift key plus 

left mouse button and drag the line to its new position and then release the mouse button. 

4.6 SNAPPING 

Definition: attaching one line to another in an unambiguous way by creating a single, common 

node. 

Snapping is necessary in order to create complete, watertight polygons in the section and avoid 

uncertainties in the connections between lines by spatial proximity alone. 

Snaps can be identified by the double circle drawn around the join.  The centres are coloured 

according to the type of snap node. 

The following types of snapping are available in the section window: 

1. correlation line to correlation line. 

2. correlation line to fault 

3. correlation line to profile 

4. fault to fault 

5. fault to profile 

6. correlation line to intersecting section 
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7. correlation line to outcrop/subcrop/faultcrop 

8. correlation line to end of section 

9. fault to mapped fault 

10. subdivision marker at the end of a line 

To snap two lines together is normally a case of dragging the end node of one line towards the 

other object. When they reach a certain proximity the two objects will be “snapped” together. 

Once snapped together the two lines can be edited together using a single operation. 

In order to unsnap a node, the CTRL key is held down simultaneously with the node being 

dragged away from the snapped node.  This option is available to all types of snaps.  

Different types of snaps behave differently when trying to drag without the CTRL key being 

used. These differences are explained below. In all cases, one of the lines must be made active 

before attempting to edit. 

Correlation to correlation line snaps can 

be moved by holding the left mouse button 

down over the node and dragging the node.  

This causes the matching snapped line 

node to also move. The inner circle is 

coloured to show the colour of the rock 

code to which the line is snapped. 

 

Correlation line to fault snaps can be moved 

by holding the left mouse button down over 

the node and dragging the node.  This causes 

the matching snapped line node to also 

move. The inner circle is coloured red to 

show this type of snap is FAULT STICK. 
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Correlation line to profile snaps cannot be 

moved.  If the snap is invalid and needs to 

be changed, the snap must be removed by 

dragging away using the CTRL key, then re-

snapped in the correct position, or the node 

can be deleted.  The inner circle is coloured 

green to indicate PROFILE SNAP. IMPORTANT: when snapping a correlation line to the 

profile, if a GRID object is set as the model cap, Groundhog will query the grid layer to obtain 

an exact profile elevation at that position and will insert it into the profile automatically. In 

some cases this is not desirable.  The first time you snap to the profile during a Groundhog 

session you will be asked whether to allow Groundhog to auto-sample the model cap each time, 

or to switch off this feature for the entire session. 

 

If you choose to keep the dynamic model cap sampling active, but wish to switch it off for a 

particular snap operation, simply check Freeze Profile in the section window settings panel on 

the right to temporarily suspend the auto-sampling for that cross-section. 

 

Fault to Fault snaps can be moved by 

holding the left mouse button down over 

the node and dragging the node.  This 

causes the matching snapped line node to 

also move.  The inner circle is coloured 

blue when this type of snap is first created 

to indicate Y-FAULT SNAP.  

However, by making either line active and 

right-clicking on the snap node at the Y-

intersect, the rock code that should be used 

to colour the area at the base of the Y can 

be selected from a list. The inner circle now 

changes to show the colour for the chosen 

rock code. 
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Fault to Profile snaps cannot be moved.  If the 

snap is invalid, the snap can be unsnapped using 

the CTRL key, then re-snapped in the correct 

position, or the node can be deleted.  The inner 

circle is coloured green for this type of snap. 

 

Correlation line to Intersecting Section snaps cannot be moved in the W direction, i.e. from 

side to side.  However, they can be moved 

in the vertical direction, up or down.  This 

is provided that the corresponding section 

is also loaded into the workspace.  If it is 

not loaded, the node cannot be moved, only 

unsnapped or deleted. An edit in one 

section will be automatically mirrored in 

the crossing section. 

Outcrop/Subcrop/Faultcrop snaps are special snaps that are snapped to croplines in the map 

window.  A cropline marker shows the position on the profile where corresponding to the 

position in the map window. To display the cropline markers click on Show/Hide Cropline 

Markers in the section window settings panel on the right. 

 

Outcrop snap.  

As the end node of the correlation line is dragged towards position on the profile corresponding 

to the cropline for this rock code, two parallel vertical lines appear in the colour of the matching 

rock code, marking the area where the node should be snapped.  Within this vertical region, 

drag the correlation line node up to the profile to snap exactly to the corresponding Cropline 

position. 
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Once the node is snapped, it cannot 

be moved, only unsnapped.  The 

marker now has a double line around 

the square to show that it is snapped. 

 

 

 

Subcrop snap 

As the end node of the correlation 

line is dragged towards the cropline 

position for this rock code, two 

parallel yellow lines appear, 

marking the area where the node 

should be snapped. 

Once the node is snapped, it cannot 

be moved, only unsnapped.  The marker moves down onto the correlation line to which the line 

has been snapped and now has a double line around the square to show that it is snapped. 

 

Fault crop snap. As the end node of 

the correlation line is dragged 

towards the cropline position for 

this rock code, two parallel lines 

appear, marking the area where the 

node should be snapped. 

 

Once the node is snapped, it 

cannot be moved, only 

unsnapped.  The marker moves 

down onto the fault and now has 

a double line around the square 

to show that it is snapped.  Fault 

crop snaps also have a diagonal 

line across them, to distinguish 

them from other crop snaps 

 

Section End snaps are slightly 

different from other snaps in that 

they can be unsnapped without 

using the CTRL key.  The snap 

marker is a large black dot. It is 

important that correlation lines 

be snapped to ends of the section 

for clean linework. 
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Mapped fault snap. This type of 

snap snaps the fault drawn in 

the section to the fault drawn in 

the map window.  The position 

where the fault line drawn in 

the map window, cross the 

section, is shown by the dotted, 

red, vertical line.  It can be 

unsnapped without using the 

CTRL key. 

4.7 JOINING CORRELATION LINES 

To join two lines together simply drag one end node towards the other end node. This creates 

one single line where the geological attribution is the same – i.e. the two lines will be merged 

into a single geometry. 

 

 

If the join is between correlation lines with different rock layer codes then the two lines remain 

as separate objects with a ‘JOIN’ snap node between the two as shown below. 
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Such dis-cordant joins are currently displayed as a sharp vertical boundary. Future versions of 

the software may enable configurable graphical representation as a zig-zag or graduated 

transition. 

 

4.8 DELETING LINES 

To delete a line simply make the line ‘active’ by clicking on it, then either right click and 

respond to a yes/no dialogue box for confirming deletion, or hit the delete key and respond in 

the same way to the dialogue box. 

Note that deleting a line is undoable. 

4.9 COPYING LINES 

Lines can be copied by specifying a vertical offset for the new line. 

First, make the desired rock code for the new line active. In this case we wish to create a 

new line of Sherwood Sandstone (SSG-SDST rock code). 

 

Select the line to be copied and use right-click > Copy Line. 

 

Enter a vertical offset in metres. A positive value will copy the line above the current line, and 

a negative value will copy it below. Here we opt to copy the line 35m below the current line. 
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The new line is added to the cross-section. 

 

Continue adding copied lines to build up the section as desired. 

Note that copying lines is undoable. 

 

4.10 WORKING WITH TERRAIN AND ELEVATION PROFILES 

Elevation grids can be imported as ASCII files and used to generate profiles in cross-section. 

Use the data import screen  or choose Interoperability > Import > GIS > 2D ASCII Grid 

(*.asc) to bring the data in. As the grid is imported it will be auto-converted to binary 

Groundhog format for rapid querying purposes, and a copy will be saved out to the same folder 

as the source *asc file (subject to folder permissions), or to the local workspace cache. Imported 

grids appear under Reference Objects > Grid Coverages in the object tree. 

Any grid profile can be displayed in cross-section, but the profile used to cap a cross-section is 

treated in a special way and is referred to as the ‘model cap’ or terrain profile. To set a grid as 

the source for a model cap/terrain profile, select it from the Capping Layer drop-down in the 

SETTINGS tab on the main window ribbon toolbar, or right click on the entry in the tree and 

choose Set As ‘Model Cap’. 

 Viewing Profiles in Cross-Section 

By default, each time you view a cross-section that does not have a terrain profile line, one will 

be auto-generated by sampling the grid layer currently set as the ‘model cap’ object. Usually 

this only takes a second or two. The resolution of the sampling is controlled by the Profile Node 

Count in the main SETTINGS tab (see later section for details on how to change the resolution). 

Elevation grids that are not currently set as the ‘model cap’ object can also be displayed as 

profiles. These objects are referred to as ‘modelled object grids’. They are hidden by default. 

To switch them on use the check boxes in the Grids tab in the section window object control 

panel. 
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By default the profile will be drawn in light gray colour. To change the colour of a modelled 

object grid profile, right-click on its entry in the object control and choose settings. 

 

Click Set Line Colour n the settings dialog. 

 

Choose a colour and click OK. Close the settings dialog. 
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 Editing The Terrain Profile 

The model cap/terrain profile can be edited. This can be useful if you need to over-ride the 

sampled grid to add details proven from other sources, such as excavation plans or artifical 

ground maps, that are not present in the grid source data. Other types of elevation grid 

(modelled grids) are just graphical and cannot be edited. 

IMPORTANT: Before adding detail manually, first consider whether the detail is really absent 

from the source grid data, or whether it is only missing due to coarse grid sampling in the 

profile generation. If the grid contains the necessary detail, do not add it manually – instead, 

increase the profile sampling resolution and update the profile to bring in more detail from the 

source grid (refer to later section on changing the resolution of elevation profiles). 

To edit the profile line, first click on it to make it active as with any editable line. Then drag 

and add nodes as described earlier (see editing lines).  

This is useful where you need to add fine detail such as a new artificial ground area, or say a 

channel which had been obscured when the original DTM was recorded, or is only visible at 

finer detail than currently available in the grid. 

Note that the freeze profile option mentioned under the settings section does not prevent editing 

of the line, but is rather to control the snapping to profile of geological line work. 

 Generating a Terrain Profile Manually 

In cases where no digital terrain model is available, or where a manually created cross-section 

profile is desired (for example where you wish to digitize over an image), it is possible to create 

one interactively. Click on the Create Fixed Elevation Profile button in the cross-section 

settings panel. 
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Confirm that you wish to generate a profile. 

 

Enter the desired elevation value (for negative values, prefix with a minus sign). 

 

A fixed profile with ten vertices is generated at the specified elevation and can then be manually 

shaped as desired. 

 

 

IMPORTANT: Bear in mind that if a terrain model grid is loaded into the workspace and set 

as the Model Cap, if you snap a correlation line to a manually created or edited profile, the 
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value from the grid layer will still be queried. To prevent this from happening make sure to 

check on “Freeze Profile” in the cross-section settings panel. 

 Changing the Resolution of Elevation Profiles 

You can adjust the model cap grid sampling resolution of elevation profiles within the cross-

section windows. The resolution setting is global and can be set using the Profile Node Count 

control in the main window Settings tab. This list contains a number of presets, but you can 

also type custom values in. 

 

The setting controls the approximate number of sampled vertices along the cross-section – for 

example, a setting of 50 will create a profile in the cross-section with approximately 50 vertices 

along its length. The default setting is 200 which generates a resonable profile quickly in most 

situations. 

If you want a full-resolution profile, choose “FULL” from the options. This will sample the 

profile at the same resolution as the grid data. 

Once you have made your selection, any elevation profiles generated after that point will use 

the new setting. If you need to update an existing profile with the new setting, use the Update 

Profile(s) button within each cross-section window to refresh the profile(s). 
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The Update Profiles option prompts you to choose which class of profiles to update. This can 

be useful where you want to see non-model cap (non-terrain) elevation profiles (for example a 

groundwater level grid) at a different resolution without affecting the model cap profile. 

 

 

IMPORTANT: Using a high resolution model cap (terrain) profile in a cross-section may lead 

to poor performance due to the large number of vertices to be checked for snapping operations. 

In case of problems please refer to the Simplifying Elevation Profiles section of this manual 

which describes how to reduce the node density of a detailed line. 

You can specify the default setting for the workspace permanently by adding an entry to the 

workspace’s tab-separated RESOURCE.txt configuration file. Here are three examples, the last 

example shows how to set the sampling to full resolution; 

PROFILE_SAMPLE_DENSITY            50 

PROFILE_SAMPLE_DENSITY            300 

PROFILE_SAMPLE_DENSITY            FULL 

 Simplifying Elevation Profiles 

Profiles within cross-sections can be simplified using a line simplicfication algorithm (Douglas 

Peucker). This can be useful where you are using profiles at high resolution and need to remove 

some of the nodes from the profiles to improve performance whilst retaining the overall detail 

of the line. Within the cross-section window settings panel, click Simplify profiles. 

 

Select which class of profile to simplify. 
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Specify the tolerance (metres) for the simplification. Start with a small value (e.g. 0.5), and 

work up to a larger value if you are not sure. 

 

 

 

 

 

 

4.11 SHOW/HIDE LAYERS 

To make lines visible or invisible tick the relevant box in the <section name> objects -> 

Correlated units list in the right hand side Settings and Objects window. Ticking a box makes 

that unit visible, with un-ticking making it invisible. Example shown below. 
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4.12 DRAWING SUB-DIVIDED STRATIGRAPHY 

It is possible to sub-divide stratigraphy in a basic way within Groundhog Desktop. There are 

two scenarios, but the basics are the same. 

1) Where the base of the parent horizon is itself already subdivided, 

2) Where the base of the parent horizon is attributed with a single rock code. 

 Parent Horizon Is Sub-Divided 

In this case, the base line is already comprised of more than one line joined together. Simply 

draw in the sub-division base, and then drag each end of it across the join position in the parent 

base horizon to snap to the appropriate location. 

 

 

 Parent Horizon Has A Single Code 

In this case, simply draw the sub-division base within the parent horizon’s polygon, then make 

the line active and use Right-click > Mark As Sub-Division. 
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The parent line below is actually split into separate lines using a JOIN-type snap object. The 

sub-division line has sub-division marker snaps nodes attached at both ends.

 

 

 

You can now draw additional child layers either above or below the existing one. To conect 

them to the same sub-division level, drag their end vertices towards the end of the existing sub-

divions (from left to right). When they get close they will snap to the correct position. 

 

 

 

Moving either a join position in the parent base, or a sub-division marker at the end of a child 

horizon will cause the other to follow. To dis-connect, hold down CTRL key and drag one of 

the snapped nodes away. 
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4.13 WORKING WITH FAULTS IN SECTION 

The expression of a fault plane within the plane of the cross-section is captured by drawing a 

line referred to as a Fault Stick. To draw a fault stick, select the code “Fault” from the codes 

panel, and start drawing. 

Correlation lines must be split across the fault sticks, and then snapped to either side, usually 

with an offset representing the displacement on the fault. This can be done either by drawing 

the fault first, and then drawing two correlation lines either side, or by drawing a single 

correlation line, and then drawing a fault line through that line to split it. 

Draw fault stick, followed by two correlation lines. 

  

Alternatively, draw correlation line, then draw fault stick through the line to split it. Carefully 

dragging the end node of the fault stick will actually push back the correlation line. 

Alternatively, just drag the ends of the correlation lines away to create the gap. 
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Snap the two correlation lines to the fault stick to represent the displacement on the fault plane. 

Faults can be drawn normal or reverse. Once snapped together, the snapped node can be 

dragged to update both lines simultaneously. 

  

Drawing Fault Sticks at Cross-Section Ends 

Where fault sticks are snapped to the start or end of the cross-section, special consideration is 

necessary. 

If the top of the fault stick is snapped to the start or end of the section, just draw normally 

around the fault. 

 

If you experience problem with layers colouring up in these scenarios, try adding an extra node 

to the top segment of the fault stick (known issue). 

 



OR/15/046; Final 1.1  Last modified: 2017/07/17 09:31 

 70 

 

If the bottom of the fault stick is snapped, and the section does not colour up correctly, 

Groundhog may need more information about the geological situation at the snap position. For 

example; 

 

In these scenarios, you must set the rock code attribute at the snap position. To do this, make 

the fault stick active by clicking on it, then right-click directly on the snap node at the bottom 

of the stick and choose > Select Base Unit. 

 

A list of recently drawn rock codes will be presented. Pick the one that is present at the snap 

position (in this case “ARPS-PSSP”). If you have not recently drawn that layer, to get the value 

to appear in the list, draw a temporary correlation line of that code in order to get it added to 

the recent list, which you can then delete after the attribute has been set. 
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 Referencing Mapped Faults 

Any faults drawn in the map window (fault traces) which intersect the line of the cross-section 

will be displayed as a vertical dashed marker line. If the faults are named they will also be 

labelled. The top of a fault stick can be attached to this marker to make a connection between 

the two objects. This is helpful when grouping fault sticks by-fault, for example if you wish to 

export the geometries to a 3D or CAD package for meshing or modelling. Simply, drag the top 

vertex of a fault stick towards the fault trace marker to make the connection. Once connected 

the top vertex can only be moved vertically. To remove the connection, hold down the CTRL 

key and drag away. 
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 Naming Faults 

Mapped faults and fault sticks can have names associated with them. This can be useful if you 

have a fault naming scheme you wish to use for ease of identification. 

To name a mapped fault (fault trace), right-click on its entry in the object tree and choose Re-

Name Fault. You will be prompted to also name any fault sticks that are attached to this fault 

in cross-section. In general, the name of the mapped object over-rides the name of individual 

fault sticks, so a re-name here will re-name the associated fault sticks, even if they were 

previously named. 

To name a fault trace, make the line active in the cross-section, and use right-click > Re-Name 

Fault Stick, and enter a name in the dialog. 

 

If the fault stick already has a name that is inherited from a connection to a mapped fault, you 

will not be able to rename the individual stick and will see this message. 

 

If you connect a fault stick to a mapped fault marker and the mapped fault (fault trace) already 

has a name you will be prompted to confirm that the fault stick will inherit the name label of 

the mapped fault. 

 

If you connect a named fault stick to the marker of an un-named mapped fault (fault trace), or 

if you name a fault stick that is already connected to the marker of an un-named mapped fault 

(fault trace) you will be prompted to name the mapped fault using the same name. 
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4.14 WINDOW SETTINGS 

In the same right hand side Settings and objects window, click on the settings tab. This brings 

up a series of buttons and checkboxes. As shown: 

 

Background Colour 

To set the background colour click on button labelled same and choose a colour in the new 

pop-up window. Click OK after choosing colour. The colour is now applied to the backdrop of 

the section. 

Colour Fill 

Turns the rock unit colouring on and off in section. 

Ornament Fill 

Turns the ornament display on and off in section. 

Show/Hide Snaps 

Tick or un-tick the checkbox labelled show snaps to switch between visible and invisible for 

the snap nodes. 

Freeze Profile 
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The software will automatically resample the DTM  when snapping correlation lines work to 

the terrain profile, in order to get the highest resolution on the snap position. However this is 

not always desirable. To freeze the DTM profile line so that re-sampling is NOT applied on 

snapping, check the box with same name. 

When the box is un-ticked the profile will be re-sampled to finer detail as the snapping takes 

place, when this is appropriate (not already at highest resolution). This allows exact snapping 

to a DTM without the need for full resolution detail along the entire profile. 

Show Polygon Borders 

This will draw black borders around the polygons. This can be useful to highlight the 

stratigraphy, especially if several similar colours are in use in the legend. 

Show Polygons 

This is checked on by default, and simply provides a way to switch off the polygon rendering 

should you wish to work with the raw linework only. 

Borehole Options 

Boreholes will automatically appear in the section if your section drawn in the plan window 

includes boreholes as node points (coincident in space). 

 

To alter the display characteristics of the borehole choose <section name> settings from the 

RHS menu. Click on Borehole Options and you will get the dialogue box: 
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Borehole Width – sets the graphical width in the section display 

Textures – not yet implemented 

Labels – shows/hides labels 

Show strat instead of lith – toggles between lithology codes and lithostrat codes (if available) 

for borehole rendering and labelling 

Collar height – set the collar height mode; 1) use heights from data only 2) hang boreholes 

with missing collar heights off the terrain profile 3) hang ALL boreholes off the terrain profile. 

Note that logs hung off the terrain display with red borders and labels in the section window 

for clarity. 

Clean Section 

This button cleans up the Section linework by 1) removing invisible duplicate vertices 

(including vertices closer together than the tolerance set by the software), the presence of which 

can prevent the colouring up of the section polygons, 2) removing zero-length lines (lines with 

only a single vertex) and 3) adding a 3rd vertex to the mid-point of lines with only two vertices 

as lines with only two vertices are difficult to snap correctly. 

If you find that your section is not colouring up in full, this option will resolve the issue in cases 

of node duplication.  

Trim 

Trims lines back to section extent. Useful for cleaning up imported cross-sections where the 

correlation lines extend beyond the line-of-section. 

Update Profiles 
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This button reloads the DTM profile in the section by re-querying the grid layer that is current 

set as the Model Cap. The layer can be changed by selecting it from the pull-down options in 

the main toolbar, or by right-clicking on a grid layer in the reference objects tree and selecting 

“Set as model cap”. 

Choose a different DTM from the LHS object reference menu under the ‘Workspace’ tab, under 

which appears the expandable node ‘Reference Objects’. Expanding this shows another 

expandable node – ‘Grid Coverages’. Under this node is a list of DTMs which you can use as 

a section cap. 

IMPORTANT: You should only use this option if you need to switch to a different terrain 

model for the cross-section profile. Once you have done this you will need to re-snap any 

linework that is drawn up to the old profile. 

Create Fixed Elevation Profile 

Firstly a dialog asks the user to confirm that they wish to generate a fixed elevation profile.  

Upon confirmation, a 2nd dialog box requests the elevation value: 

 

 

Simplify Profiles 

Firstly a dialog asks the user to confirm that they wish to generate a fixed elevation profile.  

Upon confirmation, a 2nd dialog box requests: 

 

A further dialog then asks: 

 

After a tolerance value has been entered and accepted here, the selected profiles are simplified, 

by removing all nodes that have a depth within the tolerance value of the node next to them, 

Check Geological Sequence 
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This button will be implemented in future versions of Groundhog. 

Cropline Markers 

Markers are placed along the profile where a cropline on the map crosses the section line in 

plan. This allows for section linework (e.g. correlation line) to be kept spatially coincident with 

map linework of the same unit. The linework in the two 2D ‘planes’ are then tied together. This 

is achieved by snapping the line in the section to the cropline marker (see section on snapping). 

Such croplines can be both surface crops and sub-surface, the latter being where a unit sub-

crops against another unit. 

Switch cropline markers on and off using the button ‘Show/Hide Cropline Markers’.  

Export to SVG 

This button allows you to export the section to XML based Scalable Vector Graphics format. 

This vector format is supported by many graphics packages and can be useful for producing 

high-quality report graphics. 

Quick Stats 

Selecting this options displays a window with all the rock units within the section, with the 

area in square metres and percentage of the total rock shown. 

4.15 FIXED DISPLAYED ELEMENTS 

Other elements displayed on the section are fixed. These include: 

1. Crossing sections.  

Modelling involves the building up of fence diagrams which consist of individual sections in a 

mesh. Each section in the meshwork that crosses the active one will be displayed as a black 

vertical line with a label (section name) at the base. 

2. Fault positioning lines. 

These appear as vertical dashed lines in red. They are used as an aid in ‘attaching’ a fault stick in 

the section to a fault drawn in the map window (see section on Faults). This then ties together 

this fault stick with the larger ‘parent’ fault drawn on the map (a fault is made up of several such 

sticks drawn in different sections in the fence meshwork). 

4.16 ATTACHING AN IMAGE 

When creating a new section it can be useful to overlay an existing image to act as a backdrop 

when drawing linework. Good examples would be seismic traces, in the field quarry/cliff face 

images etc.  

Follow steps below: 

1. Load the image into the workspace. On the top menu go to Interoperability -> Import -> GIS -> Image 

(Including Geo-Registered Images).  Alternatively click on the Load an Image icon in the toolbar.  The 

image then appears under the LHS referenced objects window under Workspace ->  Images. 

2. Bring the image into the section window by right clicking on the section in the data tree and choose Tools 

-> Associate/Disassociate Image. In the dialog presented choose the desired image from those loaded in 

the session.  If an image has already been associated with a cross section, it can be disassociated here. 
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3. The image will appear at a small default size. Click and drag to expand to the required size. The top left 

node on the image is used to position the image (drag to position), and the bottom right node is used to 

stretch it (drag to resize). 

 

 

 

4. Images can be made visible and invisible using the Images settings.  Right clicking in the Settings 

panel allows the transparency to be set for images in the cross section. 

 

5. Now draw linework over the image. 
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4.17 SECTION COLOURING UP – TROUBLESHOOTING GUIDE 

Within the section window, areas of rock (polygons) are coloured with the colour associated 

with the rock code.  For the polygon colouring to work correct the linework must be clean and 

properly snapped, otherwise the correlation linework will appear just as lines. There are a 

number of rules that must be understood, in order to make the colouring work correctly: 

Coloured polygons will only exist where snapping has taken place, so there is a proper link 

between lines.  Snap nodes must exist on both lines that are snapped together.  Occasionally, 

one of the snap nodes may be lost, so it is important to check that this has not happened. It is 

easy to tell because each correct snap will have two circles, an outer black circle and a smaller 

inner filled-in circle of various colour. 

It is also important that correlation lines that go to and beyond the end of the section are snapped 

to the end of section.  If your section has many lines running beyond the section extent use the 

Trim button in the settings panel. 

When troubleshooting colouring up of a section, always try the Clean Section button in 

the section window setting panel. This looks for common problems and addresses them 

automatically. 

There are a number of reasons why coloured polygons are not always created.  These include: 

 Duplicate nodes – in order to check this, moving each node in the polygon should reveal whether or 

not there is another node underneath it.  However, to simply remove all duplicate nodes, click on the 

Clean section button on the Settings tab (see example below) 

 Disordered nodes – sometimes there are two nodes at the end of the section, with different Z values. 

One of these needs to be removed. 

 Crossing lines – if lines cross, polygons cannot be formed. All polygons must be simple polygons 

http://en.wikipedia.org/wiki/Simple_polygon . 

 Nodes very close to each other – these can produce strange angles and have a similar effect to 

crossing lines.  Moving a node slightly solves the problem. 

 Lines that run back on themselves for a small segment. 

 Lines that look like one, but are actually comprised of several lines that need to be merged ("joined"). 

The following diagrams illustrate some of these problems: 

  

Lines extending beyond the end of 

section 

Click this 

button 

http://en.wikipedia.org/wiki/Simple_polygon
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Using the trim button has cut all the lines back to the section boundaries and solved some of 

the problems: 

 

However, after snapping some of the nodes, there is still a problem and the area above the chalk 

(yellow) is still not colouring up. The section below has been vertically exaggerated to show 

the problem more clearly. 

 

One of the correlation lines does not quite reach the end of section, as demonstrated within the 

red circle.  Also, if there are duplicate nodes along some of these lines. Clicking the Clean 

section button solves this problem. 
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After snapping the remainder of the unsnapped nodes, the section is now coloured correctly: 
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In the following section the yellow line looks like it is one correlation line: 

 

In fact it is two lines, which is causing some polygons to fail. 

 

These two lines, which have the same rock code attribution, need to be joined together, by 

dragging one of the end nodes of one line towards the end node of the other line. Note that 

simply joining these two lines has fixed two polygons – the yellow one and the more laterally 

extensive brown polygon. 
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If two lines cross the section will not colour up properly 

 

Snapping the lines back to the other line, solves the problem 
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Having two nodes on the end of section boundary for the same line, causes a problem 

 

Deleting one of these nodes solves the problem. This situation is not always obvious, so if you 

have a problem polygon always try an un-snap and a re-snap at each end of the line – this may 

reveal duplicate nodes and other issues that are not graphically apparent. 
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5 Log Window and Borehole Editing Functions 

Borehole logs can be edited directly in the object tree or graphically in log window view.  The 

functionality is identical for both, but is described here using the log window.  The log window 

is template based and you can design your own borehole log templates to work in. 

5.1 LOG WINDOW TEMPLATES 

The log window is customisable using the concept of templates. Groundhog Desktop ships 

with basic, default templates to get you started. These are non-modifiable, but can be copied 

and changed, or new templates can be created interactively. 

Templates can be modified in several ways.  These include: 

Clicking on the Open a new log window button: 

 

Right clicking against the selected template in the tree, then selecting View Template: 

 

 

Right clicking against a borehole and selecting View In Log Window: 
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All three options, above, require an existing template to be selected.  Alternatively, a new 

template can be created from scratch, by right clicking against Templates in the tree (under the 

Resources folder) and selecting New Template.  

 

All these options will allow editing of a template, but only selecting View In Log Window from 

a borehole in the tree will display the template together with the borehole data.  The other three 

options open an empty template in isolation from any data. You may find it easier to edit your 

templates with some borehole log data displayed as this gives a clearer view of how the logs 

will look. If you do not have any borehole data loaded you can create one to work with by 

clicking the Create a new borehole object option from the Welcome screen. 

 

Each Template is comprised of three areas; the Header, Tracks and Footer. 
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1. Header – provides cells for a title and other key fields to be labelled up, and a region in the top left for 

an icon or logo of your choice. 

2. Tracks – multiple tracks of different types are displayed here. The tracks can be used to display the 

borehole data and other key depth-related information such as scale bars. 

3. Footer – provides space for a basic text label. 

The dimensions and settings of these regions can be edited.  However, in order to do this, the 

template must be switched to “edit mode” using the toolbar button, 

 

Or via right-click in the log window, 
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When the button icon is red the template is editable.  If it is black, it is non-editable. When the 

template is editable its region lines turn blue in the log window. Clicking on the Edit Template 

button repeatedly toggles between the two modes. 

 Resizing Regions 

Most lines which bound the various regions in the template can be dragged to a different 

position using the mouse.  If a line is moveable, it turns green as the mouse passes across it. 

The line can now be dragged to the new position using the left mouse button. 

 

 

When resizing tracks, the percentage of the total area being used by the track on the left and on 

the right of the line are shown in green: 
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 Re-Ordering Log Tracks 

Tracks can also be repositioned by placing the mouse in the header section of the track and 

starting to drag: 
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As the track starts to cross the next track, the header changes colour: 

 

Once the mouse is over the new track, the header turns green again and the track can be dropped 

in its new location: 
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 Editing Template Header 

The template header is comprised of three areas. 

 

There are a series of context menus which appear on the right click of the mouse, but vary, 

depending on where the mouse is. All the header areas have the following four options available 

on right click, 

1. Page Setup 

2. Fit to Page 

3. Watermark 

4. Stop Editing Template 

The other menu items are context specific and will be described under the areas they relate to. 

5.1.3.1 PAGE SETUP 

The following options are available within the Page Setup dialog: 

 

Page Size: None, A0, A1, A2, A3, A4, A5, A6, Letter, Legal, Foolscap, 

Units Per Page: There are a number of pre-set values available, but any number can be typed 

into this box, 

Unit Type: Metres/Feet, 

Start Height: Any positive or negative integer. Normally this should be set to zero (0), 

Font Size: The font point size to use for the template, 

Font:  List of available fonts.  

5.1.3.2 FIT TO PAGE 

This option automatically sizes the template to fit into the Page Size, which has been previously 

chosen using the Page Setup function. 
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5.1.3.3 WATERMARK 

A dialogue box requests the text that is required for the watermark.  This is then printed in the 

header area of the template. 

5.1.3.4 STOP EDITING TEMPLATE 

Turns off edit mode. 

5.1.3.5 LOGO 

An image file can be chosen either from the workspace or from a file location.  This will then 

be displayed in the Logo area of the template header. 

5.1.3.6 TITLE 

On selecting the option to edit the title, the following dialog box appears: 

 

Type in the value to be displayed into the Value box. You can insert any of the preset fields 

from the lower panel by highlighting the required entry and clicking Insert – this will insert 
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the value at the current text cursor position in the Value field. The final value in the Value field 

can be any combination of free text and preset fields. 

5.1.3.7 HEADER FIELDS 

An existing field can be edited in the same way as discussed above, by selecting Edit Field 

from the menu.  This gives the same dialogue box shown above. 

If more fields are required, either a column or a row can be added: 

  

Once new fields have been added, they can be edited in the manner described above. 

Header fields can only be deleted as whole rows or whole columns by selecting the Delete 

option. 

 Editing Tracks 

Right clicking anywhere in the track header gives the following menu: 
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Many of these option have already been described above, with the exception of the following: 

5.1.4.1 RESET ALL TRACK WIDTHS 

Re-distributes all tracks to have an equal width within the template. 

5.1.4.2 SET TRACK TO A SPECIFIED WIDTH 

A dialogue box requests the percentage of the total track width to assign to this selected track.  

If the track is any track other than the furthest on the right, adjusting the track size will also 

correspondingly adjust the size of the track to its right. For the furthest track on the right, 

adjusting its size will also adjust the track on its left.  E.g. if track number 1 has a percentage 

value of 25% and track 2 also has a percentage value of 25%, adjusting track 1 to 20% will 

cause the width for track 2 to be adjusted to 30%. 

5.1.4.3 INSERT TRACK ON LEFT/RIGHT 

Inserts a new track to the left or right of the currently selected track.  This is achieved by halving 

the width of the selected track and creating a new track of the same width (half the size of the 

original track).  Sizes can be adjusted afterwards, as required. 

When inserting a new track you need to specify the type of renderer to use. The different 

renderers draw the data or depths in various ways. Depending on the type selected you may be 

prompted to select a data field to use to populate the track, for example “LITHOLOGY”. 
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Groundhog Desktop is shipped with some default track renderers, examples of which can be 

seen below. 

 

For all types of track apart from a depth track and a marker depth track, it is also necessary to 

supply details of which measurement to base the track rendering on.  If there is borehole data 

associated with the template, a drop down list of possibilities is provided.  Otherwise, the name 

of the measurement field must be typed into the box e.g. “LITHOLOGY” or “GR”. By default 

the name of the field is used as the track header label. 
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5.1.4.4 INSERT TRACK ON RIGHT 

This is essentially the same as the option above, but the track appears to the right of the selected 

track. 

5.1.4.5 DELETE TRACK 

A dialogue box requests confirmation that this track is really to be deleted.  Upon confirmation, 

the track is deleted and the space previously used by the track allocated to the track on its right.  

If the track is the rightmost track, its space is given to the track to its left. 

 Editing Template Footer 

The template footer can be edited by selecting Edit Footer Label from the right click menu.  

This provides a text box where the label value may be typed in. 

 Track Settings 

Each type of track has its own settings dialogue, which enable customisation of the track 

rendering.  These are as follows: 

Interval tracks: 

 

Curve tracks: 
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Depth tracks: 

 

Text tracks: 

 

 Saving a Template 

On exiting Groundhog, a confirmation dialogue box asks for confirmation as to whether or not 

any changed templates should be saved. 

Templates can also be saved at any time by clicking the Save button: 
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This button is only enabled when there are changes to save. 
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5.2 VIEWING AND EDITING A BOREHOLE LOG 

To open a borehole in a log window, right click against the borehole and select View in Log 

Window. This option is available in the object tree, the map window and the cross-section 

window. 

 

A drop down list asks which log template should be used: 

 

 

IMPORTANT: Although, technically, Groundhog boreholes can contain multiple distinct 

geology logs, the log window templates will only display the data from the first one. 
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Intervals can be edited, inserted or deleted. Within an interval type track, right-click on the 

desired interval to see the available options (note, these options are also available on right-click 

in the tree): 

 

 

 Editing an Interval 

The top and base value for an interval can be edited and attributes can be amended, added or 

deleted: 
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To modify the top and/or base value, the up and down arrows can be used next to the values.  

Alternatively, a new value can be typed into the box.  Amending the top or base automatically 

changes the thickness.  The thickness can also be manually changed and doing this 

automatically changes the base.  There are restrictions on what values can be entered, which 

ensure that any adjoin intervals cannot be completely consumed by the unit being edited.  At 

least 1 cm of depth must remain in any adjoining interval, after the changes for the current 

interval take effect. 

The default measurement type for the base, top and thickness values is metres.  However, if 

the values are known in feet and inches, these can be entered using the ft/n button and they are 

then converted into metres, as all interval depth values are stored in metres. 

Where editing the top or base values of an interval cause a gap to occur between the top or base 

values of the interval above or below, a dialogue box asks: 

 

If No is selected, a gap is left in the Borehole Log.  Otherwise the affected adjoining interval(s) 

is adjusted in order that there is no gap. 

This only happens when a borehole is edited, not when a new interval is inserted.  On an insert, 

it is assumed that no gap should be left – see below. 

No overlapping areas are allowed within a borehole log.  This means that if, say, an interval 

base depth is increased, the top depth for the interval below is also correspondingly increased. 

Borehole intervals implement the concept of flexible attribution. This means that any attributes 

can be associated with an interval.  Common attributes are Lithology, Lithostrat and 
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Description, but others can be used as required.  Some attributes have dictionaries associated 

with them and can be used for lookup purposes.  Where an associated dictionary exists, a 

Lookup button is provided, otherwise this button is disabled. 

The lookup function allows various searching methods: 

 

Where more space is required in order to input a value e.g. against a Description attribute, the 

Large Textbox button opens a new dialog box: 

 

New attributes can be added or existing attributes deleted by pressing the Add/Delete Attributes 

button: 
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This gathers a list of all known attributes from all the loaded boreholes within the currently 

selected borehole data set.  Any of these can be selected.  Existing attributes can be deleted by 

de-selecting them from this panel. 

If an attribute is required that does not exist in the list, pressing the New Field button opens a 

new dialogue, allowing a new attribute to be specified: 
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In order for the new attribute to be saved against the interval, a value must be entered against 

it. 

 

 Inserting a New Interval 

Intervals can be inserted above, below, or within the currently selected intervals and there are 

rules as to how this can be done. 

5.2.2.1 INSERT ABOVE 

 

It is not possible to insert an interval above an interval that has a top value of 0.  If this is 

required, the existing interval must first be edited to change the top value to a positive number. 

Default top and base values are assigned to the new interval: 
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If the new interval is the first interval, the top value defaults to 0, otherwise the top value 

defaults to a value that is roughly half way into the interval above. The base value for the new 

interval defaults to the top value for the selected interval. 

The top and base values can be amended, but the minimum and maximum limits that can be 

entered ensure that any interval above or below the new interval, retain a very small depth 

(currently set to 1cm), in order that they cannot be entirely wiped out. 

5.2.2.2 INSERT BELOW 

 

There is no restriction on from which intervals new intervals can inserted below. 

Default top and base values are assigned to the new interval: 

The top value for the new interval always defaults to the base value for the selected interval. 

If the new interval, is the last interval, the base value defaults to a value that would give the 

new interval the same thickness as the selected interval.  Otherwise, the new interval will be 

given a base value that consumes roughly half the depth of the interval below. 

As for insert above (see above) the top and base values can only be amended to values that will 

not result in adjoining intervals being totally consumed within the new interval i.e. at 1cm depth 

must be left in any adjoining interval.  
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5.2.2.3 INSERT WITHIN 

 

This function assumes that the existing borehole interval needs to be divided into three equally 

sized chunks.  The new interval sits in the middle third.  The default values reflect this, but can 

be amended.  As with the other two insert methods, a these minimum and maximum values 

that can be assigned to the top and base values ensure that a small interval remains both above 

and below the new interval, using the selected interval attributes. 

 Delete an Interval 

When an interval is deleted, it is necessary to decide what to do with the area of the log that 

was occupied by the interval.  Depending on where the interval is within the log, the following 

dialog will appear: 

 

If the interval being deleted is either the top or the bottom interval, not all these options will be 

available. 

5.3 FILTERING 

Data sets can be filtered interactively within Porcupine. The filters are under a right-click (on 

the data set entry) > Filter dataset. 
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 Remove Boreholes Without/With Logs 

These two options allow you to remove logs without logs (interpretations), or remove those 

with existing logs. The first is useful to filter out borehole records with no downhole data, the 

second is useful to see which borehole have yet to be interpreted. 

 Cascading Interpreter Filter 

If the name of the intepreter is available within the borehole dataset, this presents a list of 

interpreter id’s (i.e. geologist names or drillers names) on the left. Click on an entry to highlight 

it and use the Copy to selection >>> button to copy it to the selection list on the right. Build 

the selection list up in order of preference, with the preferred interpreter at the top of the list. 

To re-order the list, highlight an entry and use the Move up and Move down buttons. When 

you are happy with the selection click Apply. 

 

The filter will use the list to filter the data set in Porcupine. For each borehole it will look for 

your preferred interpreters in list order – if the first one is available it will be used, otherwise 

the second, otherwise the third etc... If a borehole has no matching interpreter it will be deleted 

from the data set completely. 

 Cascading Project Code Filter 

If the name of the project is available within the borehole data, this operates in the same way 

as the cascading interpreter filter, but uses the CONTENT_CODE field (a.k.a project name 

field) of the interpretation for the filtering. 

 Cascading Interpreter + Project Code Filter 

This operates in the same way as the cascading interpreter filter, but filters by unique 

combination of INTERPRETER and CONTENT_CODE. 

 Drilled Depth Filter 

This allows you to filter by drilled depth and can be applied either as a more-than or less-than 

filter depending whether you are interested in only deeper or shallower boreholes. The settings 

below would retain only those interpretations that have a drilled depth of 25m or more. 
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 Lithostratigraphy Filter 

This allows you to filter based on lithostrat codes. The unique list of lithostratigraphic coding 

is presented on the left and can be copied to the select on the right by selecting the entry and 

using the Copy to selection >>> button. 

The order of the list on the right is not important, so there are no sorting options. The list is not 

cascading. Porcupine will use an OR test on this list when deciding whether to retain an 

interpretation – in the example below the filter would retain all interpretations that have 

CHALK GROUP or CRAG GROUP or LOWESTOFT FORMATION coded anywhere in 

them. 

 

 Confidentiality Filter 

This allows you to filter on the confidentiality code of the borehole entry, if such a field is 

populated in the borehole data. There are 5 numeric codes: 
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You can find the confidentiality of a particular borehole by hovering over it in the dataset tree 

and reading the tooltip that appears. Also, if a borehole is level 2 or 3 you will see an amber 

asterisk to the right of the log icon – if it is a level 4 or 5 the asterisk will be red. 

 

The filter gives you the option to remove levels of confidentiality from the dataset. Simply 

select the levels you wish to retain and click Apply. For example, if you do not want any 

confidential boreholes in your dataset, only select “1 – NO CONDITIONS APPLIED (NON-

CONFIDENTIAL)”. 

5.4 OTHER BOREHOLE FUNCTIONS 

 Filter Chaining 

The filters can be applied successively against the same data set to refine it. For example, if 

you were only interested in having borehole interpretations with a drilled depth of more than 

10m which have CRAG GROUP coded in them preferably by HBU but failing that by RTE 

then you could apply three successive filters to achieve this.  

 Populate Collar Heights Using Model Cap 

This tool allows you to stamp in borehole collar heights (ground start heights) using elevation 

values taken directly from the grid layer that is currently set as the workspace model cap 

(usually a DEM or DTM grid, for example). This is useful if your borehole collar heights are 

missing or un-reliable. You can choose whether to copy new elevation values from the model 

cap into all boreholes in the dataset (thus over-writing any pre-existing elevation values in the 

boreholes), or to only populate model cap elevation values where the borehole has a missing 

collar height. 

 

NOTE: Think carefully before copying in values from the model cap. This is a useful tool but 

could be confusing for onward users of the borehole data. If you are copying in collar heights 

so that the boreholes with missing elevations will render correctly in cross-section, consider 

using the Borehole Options dialog accessible via the Borehole Options button in the Settings 

tab to the right of each cross-section window, which allows you to set a policy for borehole 

collar heights that will not affect the borehole data directly. 
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 Copy/Rename Borehole Marker Attribute 

This tool allows you to both rename and copy attributes on the borehole markers. This is useful 

if your imported data has a non-standard attribute name for a common field such as lithology, 

or if you need to set a specific field name for an export. The rename option will re-label the 

attribute, whereas the copy option will create a new attribute alongside the original. 
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 Merging Borehole Datasets 

Borehole datasets can be retrieved from different sources for the same area, or from different 

areas, or a combination of these. They can then be merged together into a single dataset.  

Interpretation logs can be added post merging if necessary. 

 

To merge click on ‘Boreholes’ and choose the merge option as below. Note that the merging 

process relies on having a unique Identifier which is available for each borehole record. 
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This merging process is most useful in bringing together different sources of data for a 

borehole: all interpretations are then brought together.  
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6 Context Menus  

Some entries in the data tree have context menus attached to them, which are displayed when 

a right-click is made against the entry.  Most items have the option to draw them in a map 

window.  See section 3 for details on how to do this.  The following paragraphs describe the 

context menus that are available for each object.  If there is no description for a particular 

object, it is because they do not have any extra right click options, or because these options 

have been described elsewhere in this manual. 

6.1 CROSS SECTIONS 

Right clicking against an individual cross section gives the following menu: 

 

 View Cross Section 

This option opens the selected cross-section in a cross-section window.  Section 4 gives full 

details on how to use this window. 

 Rename Cross-Section 

The following dialog box allows a new name to be specified for the cross-section: 

 

 Attach Image 

Section Cross Section Window -> Attaching An Image of this manual describes this process. 

 Find Associated Boreholes 

This function is available both at individual cross-section level and for all cross-sections. 

It works by searching through all the boreholes loaded into the workspace to find any that have 

an id that matches the borehole id referenced in the section.  It then searches for boreholes by 

proximity, to find any that are very close (i.e. have identical co-ordinates taking into account a 
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small tolerance margin) to a borehole referenced in the section.  Any boreholes that are found 

as being linked to the section(s) are associated with them and will display in the section 

window.  The following message provides information on borehole associations that have been 

made/not made: 

 

 

 Export to GOCAD 

This feature is identical to the project export described in section 8.3.2, but a PLine (.pl) is 

created for the cross-section which has been selected.  The name and location of the file is 

specified via a file chooser. 

6.2 CROPLINES 

At cropline group level the following context menu is available: 

 

 Set As Drawing Code 

Selecting this option sets the current drawing code to the code for the cropline group.  This will 

mean that any new croplines or correlation lines that are drawn, will use this code until it is 

changed again. 

6.3 FAULTS (MAPPED) 

The following context menu is displayed for an individual mapped fault: 
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 Re-Name Fault 

This option is described in section 3.6.1 

6.4 DICTIONARIES 

 Set as Coding Scheme 

Changing which dictionary entry is the coding scheme changes the values which populate the 

values shown in the codes panel and which are linked to the legend file. This is the master list 

of rock layer codes used for digitizing in Groundhog. 

 

6.5 SHAPES 

In addition to the “View Shapes in Map” option, which is described in Section 3 of this manual, 

there are other functions which can be performed against loaded shape files: 
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 View Attributes 

This option displays a table with headings showing all the different types of attributes held for 

the shape file and, for each shape, the values for each of these: 

 

Highlighting one or more lines in the table, causes any corresponding displayed in a map 

window to be highlighted (in black): 
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Clicking on the button Clear Selected causes the highlighting to be removed. 

 Show/Hide by Attribute 

This option opens a dialog box which allows filtering of the shapes that are drawn in the map 

window: 

 

Highlighting the entry (or multiple entries) and clicking Copy to selection >>> moves the 

selected entries to the right hand side of the panel.  The Apply button then removes all shapes 

from any displayed map windows which do not contain these values. 

 

NB it is very easy to forget to click the Copy to selection >>> button.  If clicking the Apply 

button removes all shapes from the map window, this is probably the cause. 

 

 Turn Shape Fill Off/On 

If the shapes are already filled, this option will show as Turn Shape Fill Off, otherwise it will 

show as Turn Shape Fill On. 
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Selecting this option, toggles the map window drawn option between fill and no fill.  The screen 

print shown above shows the polygons as filled. The screen print below shows the same 

polygons not filled: 

 

 Convert Shapes to Croplines 

This option opens a dialog box to enable the conversion requirements to be specified: 

 

The Property drop down list shows a list of all the property types held within the shape file.  

This is the property whose value will be used for selecting which shapes are to be converted. 

The Value drop down list contains a list of all unique values held with the shape file for the 

property specified.  The first option is ALL, which allows all shapes to be selected. 

The New Cropline Code shows a drop down list of all rock codes currently specified within 

the dictionary.  Alternatively a value can be entered here that does not currently exist.  All 

Croplines will be created with this value as their rock code.   
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If ALL is selected from the Value drop down list, it is not possible to select or enter a value in 

this box.  The cropline name, in this instance, will be the same as the property value held for 

the shape. 

 Change Property Used for Colouring 

This option enables the colouring property which was selected, on loading the shape file, to be 

changed: 

 

A dialog box allows the new property to be selected: 

 

The shapes are now shown in the map window with their new colours: 
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 Clipping Linework Using A Shape 

This option can be useful when cleaning up legacy data, for example projects created in GSI3D 

or other mapping-type software. Currently there is no Undo function associated with this 

operation, so take care to keep a backup of your project in case you need to revert back to it. 

First, draw a shape to use as the clipping path. There are two ways to do this; 

1) For irregular clipping regions, draw region by hand as a shape and drag the two end nodes of that 

shape together to form a polygon, 

2) For linear clipping regions, draw the linear route by hand as a shape (line), then use the buffer tool to 

create a polygon around that line. 

With some linework (croplines) displayed in a map window, right-click on the shape in the 

map window and choose Use Shape As Cutting Path. 
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Click “Yes” to perform the clip. 

 

Choose whether to discard portions of linework that lies outside the clip shape. 

 

The croplines will be clipped. This function operates on the currently visible linework in the 

map window. 

 

 

6.6 IMAGES 

Individual images or entire folders of images can be loaded into the data tree. 

 

Or 
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Loaded images appear in the object tree under Reference Objects > Images. Right-clicking 

against an image in the tree gives the following menu. 

 

Double-clicking the image in the tree, or selecting the Preview Image option from the context 

menu displays a window containing the image. 

 

 Automatic Image Caching 

When a project is saved out from Groundhog any image references will be cached into a sub-

folder called LINKED_DATA_CACHE. This ensures you still have access to referenced 

images even if you are working ‘offline’ and your images are on a corporate network. If the 

original is available it will always be used preferentially, but if it cannot be accessed the cached 

version will be loaded instead. 
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 Setting Image Transparency 

The transparency of an image can be adjusted in the map window via the control panel to the 

right. Under Objects, expand Other Objects and choose right-click > Settings on the desired 

image. Use the slider to adjust the transparency value. 

 

 Interactive Image Geo-Registration 

If the image is already geo-registered, selecting Change Image Co-ordinates allows the 

previously registered co-ordinates for an image to be changed, or if the image is not already 

geo-registered, it allows them to be entered. 
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Selecting View Image In Map allows an existing map window or a new map window to be 

selected.  If the image is geo-registered, it will then be displayed in the chosen map window.  

If the image is not geo-registered, the following dialog is shown. 

 

Choosing the first option, displays the following dialog window. 

 

This enables the top left and bottom right co-ordinates of the image to be entered by typing 

known values in. 

Choosing the 2nd option,  Manually register the image in the map interactively, places the 

image approximately within the current visible map window extent.  If a map window is not 

open, a message will request that this is done first. 

 

IMPORTANT: Note that any geo-registration information entered within Groundhog will be 

automatically saved out as a worldfile alongside both the original image (if write permissions 

are available) and in the Groundhog image cache folder when you save your project. 

Once placed in the map window, images can be moved or resized. In the map window each 

image has a detectable region in the top left and bottom right corner. Hover the mouse in either 

corner to see handles for these regions (blue squares). When the mouse is over a detectable 

region the mouse cursor changes and the image border is highlighted in black.. 



OR/15/046; Final 1.1  Last modified: 2017/07/17 09:31 

 125 

 

Right-click in either corner region and select Change Image Co-ordinates from the pop-up 

menu to manually edit the geo-registration values. 

Alternatively, register the image interactively. The top-left handle can re-position the image – 

hold down the left mouse button and move the mouse to drag the image. The lower-right handle 

can re-size the image – hold the left mouse button and move the mouse to stretch the image. In 

stretching mode the image retains its aspect ratio by default; to over-ride this, hold down the 

CTRL key. 

Re-position 

  

Stretch (maintain aspect) 
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Stretch (CTRL key over-rides aspect) 
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6.7 MULTIPLE SELECTION 

It is possible to select more than one object in the Data Tree by holding down the SHIFT or 

CTRL keys as you select an object.  This changes the colour of each selected object name to 

cyan: 

 

If there are multiple selections under a heading e.g. Cross Sections, a context menu becomes 

available, which allows actions to be performed against the objects selected: 

 

These options are Delete objects, De-select Objects, Invert Selection and View in Map. 
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7 Workflows 

7.1 FAULT CONSTRUCTION 

 

Faults can be constructed in both map and cross-section as fault linework. Where fault linework 

is created in the map these are referred to as Fault Trace objects; where fault linework is 

created in cross-section these are referred to as Fault Stick objects. Fault information is also 

attached to some map croplines and cross-section correlation lines. 

 Fault Traces 

 

Fault traces represent the top of a fault plane in the map as a simple line. These lines serve 

mainly as a reference to the surface or subsurface expression of the top of the fault plane, and 

are used to associate a series of fault sticks together from cross-sections. 

To draw a fault trace, pick the Fault code from the lower panel in the object tree Codes tab 

and use the pen or digitizing drawing tools to construct the line on the map. 
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Fault trace networks can be constructed by snapping fault trace lines together. Simply drag the 

end node of a fault trace towards the other trace. 

 

 Fault Sticks 

 

Fault sticks represent the fault plane in cross-section. They are constructed much like a normal 

correlation line. To draw a fault stick, pick the Fault code from the lower panel in the object 

tree Codes tab and use the pen or digitizing drawing tools to construct the line in the cross-

section. 

 

Positions where fault traces cross the section are shown as dashed vertical markers. This aids 

you in positioning of fault sticks to tie-in with the map traces. 

 

 

Drag the top node of the fault stick towards the vertical marker to snap it. 
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Note that fault sticks do not have to come up to the terrain profile – they can terminate within 

horizons. In the map view the top node of a fault stick is shown as a dot. If the stick reaches 

the terrain profile the dot will be red, if it terminates at depth it will be orange. 

 

Once fault sticks are constructed, correlation lines can be snapped to them, as described in 

general editing in the main Cross-Section Window part of this manual. 

 Fault-attributed Croplines 

 

Croplines can honour faults in two ways; 

7.1.3.1 1 - SNAP TO FAULT TRACE 

Croplines can be snapped to fault traces in the map. This is not always desirable, depending on 

the nature of the geology however. Two scenarios where it does make geological sense are; 

1) Where the fault plane is exactly vertical, 

2) Where the fault comes to the surface and the cropline is at outcrop. 
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7.1.3.2 2 – CONSTRUCT FAULT CROP 

Where the cropline runs into the fault plane at depth it often makes no geometric sense to snap 

the cropline to the fault trace, especially if the fault plane is non-vertical. In these cases, 

construct a cropline to represent the crop of the horizon on the fault plane. 

Consider the following map; 

 

Sketch the “fault crop” as two additional lines (implies the fault is dipping to the South East in 

this example) 
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Join the croplines together by dragging their end nodes together. 

 

Right click on the cropline segments which run along the fault crop and choose Add Fault 

Crop Attribute. This flags the cropline as a “fault crop” – note that for this approach to work 

the croplines on the fault crop must be separate objects – if necessary, split down existing 

croplines to achieve this. 

 

Fault crop attributed cropline shows with red nodes to indicate fault crop; 
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Completed linework for the blue horizon, showing two segments of fault crop (hangingwall 

and footwall crops), two other segments of normal cropline. Presence side seeds have been set 

here too (refer to editing croplines general section in the manual for more detail); 

 

Repeat for other horizons. 
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If you need to drag the end of a cropline across a fault trace without it snapping, hold down the 

CTRL key as you drag. 

 Fault-attributed Correlation lines 

 

By snapping correlation lines to fault sticks in section you can start to build up the relationships 

and throws on the fault planes. 
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Three sections above displayed as 3D linework in SKUA-GOCAD; 
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8 Interoperability 

8.1 IMPORTING PROJECTS FROM GSI3D 

Groundhog currently has no direct support for loading directly from GSI3D, and a conversion 

of the data is therefore required. For advice on how the conversion can be done please contact 

groundhog@bgs.ac.uk  

8.2 IMPORT 

All the imports described below are selected via the import menu, which is reached by selecting 

Interoperability > Import. 

 2D ASCII Grid (*.asc) 

This import function allows a different 2D ASCII Grid to be loaded into the work area.  

Selecting this option from the menu, provides a Select grid file for import dialog box which 

allows the grid file to be found and selected.   

Once the grid has loaded, it can be found in the tree structure, under Reference Objects > Grid 

Coverages.  To set it as the model cap, right click on it and select Set As ‘Model Cap’. 

 

 Import Geological Sequence From Spreadsheet 

This import function allows a Geological Sequence (stratigraphy) file to be loaded into the 

work area.  Selecting this option from the menu, provides an Open geological sequence file 

dialog box which allows the stratigraphy file to be found and selected. The stratigraphy is not 

directly used for anything at the moment, but could be a useful reference. 

Once the file is loaded, the information can be found in the tree structure, under Geological 

Objects > Geological Sequence 

 

 

The import supports a simple list, which is a spreadsheet with a single column listing the 

sequence (strat) codes, or a hierarchical sequence via the use of multiple columns. 

mailto:groundhog@bgs.ac.uk
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Simple stratigraphic sequence 

 

 

 

Hierarchical stratigraphic sequence 
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 Shapefile (*.shp) 

This import function allows an ESRI style shape file to be loaded into the workspace. The Load 

Shape File dialog box allows the shape file to be selected.  It is only necessary to specify the 

.shp file here.  Provided the other associated files (e.g. .sbn, .prj, .sbx, .dbf and .shx etc..) are 

held in the same folder, they will also be utilised by the load process. 

After selecting the file, another dialog box allows the choosing of the property to be specified 

for colouring the shape polygons. These are simply the fields from the shapefile attribute table. 

 

If a property is chosen which holds values which can be found in the dictionary and legend 

files, the shape polygons will be coloured, when they are drawn in the map window, according 

to this value. 

Once the shape file has been loaded, a dialog box confirms this: 

 

The shape file can now be seen in the data tree: 
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There are now a number of right-click options which can enable viewing and  manipulation of 

the shapes.  Refer to the Shapes section of this manual for details of the context-menus 

available for working with shape data (Section 6.5). 

 

 Import GOCAD TSurf (*.ts) File 

This import function allows a TSurf file to be loaded into the work area.  Selecting this option 

from the menu, provides a Load GOCAD TSurf file dialog box which allows the TSurf file to 

be found and selected.   

Once the file is loaded, it can be found in the tree structure, under Reference Objects > Meshes.   

 Import Well Log Data (*.las) 

This import function allows a LAS file to be loaded into the work area.  Selecting this option 

provides a Load LAS File dialog box, which allows a LAS file to be found and selected. 

This load can take a little time to run, so following selection of the file full functionality of 

Groundhog Desktop is restored, but the LAS file may be still be loading for a time.  A message 

is displayed in the bottom left corner of the window, whilst the load is taking place. 

 

On completion of the load, the following box is shown: 

 

Las data is stored as a series of “pick based” boreholes within Groundhog Desktop.  Once 

loaded, it can be viewed in the tree structure, under Geological Objects > Boreholes. 
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Individual measurements can be seen by expanding the items using the + signs.  They can also 

be seen as curve diagrams, by right clicking against an entry and selecting View In Porcupine 

Document.  This is described in more detail in the Log View section of this manual. 

 Borehole Data (*.dat) 

This option enables borehole files to be loaded using any text-based, tab separated format.  The 

files may or may not contain column headings.  On selecting this menu option, a dialog box 

requests information about the files to be loaded: 

 

The Borehole Index/Collar file should contain at least an identifier for the borehole, a collar 

height (start height) in metres relative to O.D/sea-level or site datum, an easting (X) and a 

northing (Y). Here is an example file with a header line; 

ID START_H EAST NORTH 
1 10.2  206783 345165 

The Borehole Log Data file should contain at least an identifier for the borehole (i.e. ones that 

will match with the identifiers from the index file), a marker depth (base of layer) as a “drilled-

depth” (i.e. relative to the collar height), and some form of geological coding value (lithology 
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and/or lithostrat). The file should contain one row per-marker/horizon. Here is an example file 

with a header line which specifies two markers associated with borhole “1”; 

ID D_DEPTH LITH 
1 2.4  SAND 
1 3.2  CLAY 

If all of your data is in a single file simply pick the same file twice. A combined data file must 

contain one row per-marker/horizon, meaning the index data will be duplicated if the log has 

multiple markers, e.g. 

ID START_H EAST     NORTH   D_DEPTH LITH 
1 10.2  206783     345165  2.4  SAND 
1 10.2  206783     345165  3.2  CLAY 
 

 

 

On supplying a file name for either file, the following dialog box, with the first line of data 

from the file, is shown: 

 

In this case, the answer would be No (the first line is clearly data), but a file can be loaded 

which does have column headings. 

Once the information has been supplied, the dialog box looks something like this: 

 

The Index data file used here has no header, so the columns are selected by their number. The 

Borehole Log Data file used here did contain headers, so these header names were used to 

specify which column holds which data. Any columns not present in the data file, or not desired 

for the import should be left as “NOT SPECIFIED”. 
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Note the tick in the box Logs are interval based.  It is important to tick this, where appropriate, 

if the log data is really a range from the previous depth to the current depth, denoting one 

horizon. 

Once the borehole data has been loaded, it can be found under Geological Objects > Boreholes. 

 

Individual logs can be viewed, by expanding the + signs. Boreholes can also be shown in one 

or more map windows or viewed using the Log Viewer. If boreholes are used to construct a 

new line-of-section, they will also appear in the section window. When the project is saved the 

borehole data will be saved to the XML data files for the project. 
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 Import Colours 

Additional legend colours can be loaded using this import option.  The default file type is a .dat 

file and it should be tab-separated.  The format is, as shown here i.e. [NAME   RED   GREEN   

BLUE]: 

 

Once the file has been loaded, the following message is displayed: 

 

A GSI3D .gleg file, with the standard layout, can also be loaded directly using this import. 



OR/15/046; Final 1.1  Last modified: 2017/07/17 09:31 

 144 

 Import GSI3D Projects 

You can import GSI3D project files (*.GSIPR), legend files (*.GLEG) and stratigraphy files 

(*.GVS) via the GSI3D import menu. The importer may also work with certain versions of 

other INSIGHT GmbH products, such as the SubSurface Viewer. 

Interoperability > Import > GSI3D 

If you need to import borehole data from GSI3D format data filesd (*.BID, *.BLG), use the 

generic borehole import option. 

   Interoperability > Import > GSI3D > Borehole Data 

When importing projesct (*.GSIPR), Groundhog gives you the option to auto-snap, where 

possible. This will generate snap nodes where correlation lines meet, or are close by. 

Groundhog allows you to specify a tolerance for the snapping, in metres. A value of 0.5m is a 

good default value for projects which have been previously cleaned up in GSI3D. 

Note that the GSIPR importer only imports linework, it does not bring in any TIN data, linked 

shapefiles, or linked images etc. If you need to import these, use the individual import options 

for these formats. For TIN meshes, first export from GSI3D and a GOCAD Tsurf file, which 

can then be imported into Groundhog. 

Because of the nature of GSI3D-style projects, imported croplines are likely to have portions 

of project boundary incorporated into them. To clip these away, use the clipping capability of 

Groundhog “Shapes” – refer to the section “Clipping Linework Using A Shape” within this 

manual. If you do not have the project boundary available, consider importing the project TIN 

as a GOCAD TSurf import, which will create a boundary object (Shape) that can be used for 

the clipping. 

 

8.3 EXPORT 

 Export Project To GSI3D Format 

This export enables the currently loaded Groundhog Desktop workspace to a GSI3D v2013 

format .gsipr file.  On selecting this option, a Save Export to GSI3D Project File dialog box 

allows the output destination and file name to be specified. 

A dialogue box then offers three options for how the file is to be created: 

 

The first option creates a .gsipr file, containing only the information held within the loaded 

data in Groundhog Desktop.  This will mean that some project information, for example project 

file names such as the .gvs file, will be missing from the .gsipr file and will need to be supplied 

when the project is loaded into GSI3D. 

Option 2 requests an existing .gsipr file to be specified using the Open Existing GSI3D Project 

File dialog box.  This will then merge some project information e.g. the .gvs file name and 

location, with the Groundhog Desktop data to create a new file containing all this information. 
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Option 3 – this option should be ignored for now, as it will only become relevant once the 

Geological Object Store (GOS) is available; 

Once the file has been created, the following message is displayed: 

 

 Export Project To GOCAD Format 

This option provides the Select A Folder To Export To dialog box, which enables a file 

location to be specified.  This export currently supports only the cross-sections. Map and 

borehole are still in development. 

One Pline (*.pl) format file is created for each Cross Section loaded into the current workspace.  

These are placed in the location that has been specified.  If files already exist in the given 

location with the same names as the ones produced by this function, they are overwritten by 

the new files. 

At the moment this export only operates on the cross-section objects and not on the map 

linework – this second feature is in development. 
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9 APPENDIX A – Quick Start Guide 

9.1 HELPDESK 

Please email groundhog@bgs.ac.uk for general assistance. 

BGS offers training, custom software development, integration services and geological 

consultancy services in relation to the use of the Groundhog Desktop software. For all 

enquiries please contact groundhog@bgs.ac.uk 

9.2 INSTALL & USE 

Double-click setup.exe and follow the wizard, accepting all defaults. Start the software from 

the Programs menu or from the desktop shortcut. When Groundhog starts you will see this 

screen. 

 

Just click OK to get started. You do not need to create your own workspace at this stage, so 

just leave DEFAULT selected. If you cannot see DEFAULT listed, please restart the software. 

If it still does not appear, first try re-installing the software before contacting 

groundhog@bgs.ac.uk for advice. 

The user interface appears like this. Groundhog always starts up empty, expecting you to either 

load an existing project or start a new one. 

mailto:groundhog@bgs.ac.uk
mailto:groundhog@bgs.ac.uk
mailto:groundhog@bgs.ac.uk
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9.3 MAPS 

Open a new map window. Give it a name when prompted. 

 

 

Scale to full extent.  

 

UK coastline and placenames appear, or if you are working in an empty workspace, the map 

window will just be blank. You can configure your own outline map by setting up your own 

workspace – refer to the Workspaces and Special Files sections of the main user manual. 

Choose DTM and switch on topo map here 

Drawing tools are here 

Open a new map window here 

Load/save a project  

New map and log windows 

appear here  

Cross-section windows 

appear here  

Rock codes are here  

Objects are here  
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To switch off the UK outline, un-check Boundary in the map window toolbar. 

 

This will switch the view to a generic grid overlay, with thicker black lines through the origin 

[0,0]. Note that the grid cells switch size as you zoom in and out to assist with positioning of 

data. 

 

Hide grid completely using Show Local Grid checkbox in map window Settings panel. 
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Navigate as-per google maps etc – i.e. hold left mouse button to pan, use scroll wheel to zoom. 

IMPORTANT: If you have no mouse wheel, or your wheel is not reliable, consider replacing 

your mouse as this will make Groundhog much easier to navigate. 

 

Switch on standard UK topo basemap, if desired.  

 

Map appears. Note that it re-scales based on zoom level. When new maps are loading there 

may be a slight delay (depending on speed of internet connection). 

 

If working offline, zoom into the area you’ll be working on whilst you have an internet 

connection to cache the map data, then check on Cache Only when working offline. 



OR/15/046; Final 1.1  Last modified: 2017/07/17 09:31 

 150 

 

 

Note: The basemap is served from a 3rd party service via the internet. If you experience 
difficulty accessing these maps this may be due to your organization’s IT policy or firewall 
settings, or a change in the availability of the web service. In such cases, please refer to your 
local network administrator for advice. 

 

9.4 IMAGES 

Images can be imported and, if geo-registered, viewed in the map window. Images can also be 

interactively added to cross-section windows. You can import an image by browsing for a file, 

or by dragging the file into the Groundhog window – you can also drag images off web pages 

by dragging them into the Groundhog window. 

To drag an image, drag the file icon from the desktop or folder, or drag the image from the 

webpage, and release the mouse when hovering over the Groundhog window. 

 

To import an image, select the import data tool. 

  

Highlight Images and click OK. 
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In the option box that appears, click Single Image. 

 

Browse for the required image on your computer. By default, this file chooser expects JPEG. 

If your images are in PNG format, be sure to choose All Files in the Files of type dropdown to 

make them visible. 

 

The image will now appear under Reference Objects > Images in the tree. 
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If the image is geo-registered, to view the image in the map window, right click on it in the tree 

and select View Image in Map.  The image can be viewed in an existing map window (if 

available) or in a new map window. 

 

 

Zoom and pan the window to view the image. Access transparency slider via Right-Click > 

Settings in the Other Objects list in the object panel to the right. 
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Note: A GIS software application can be used to produce a geo-registered image, such as 
the one shown above. For example, in ArcMap, use File > Export Map and make sure to 
check on the world file option. 

 

 

Images can also be displayed in a cross-section window and used as reference or to digitize 

over. The following example uses an image taken from the Thurrock model using the BGS 

online virtual cross-section tool. 

http://www.bgs.ac.uk/services/3Dgeology/virtualBoreholeViewer.html 

http://www.bgs.ac.uk/services/3Dgeology/virtualBoreholeViewer.html
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First, load the image into Groundhog, as described above. Right-click on the desired cross-

section entry in the tree and select Tools > Associate/Disassociate Image. 

 

In the selection dialog, highlight the desired image, and click Associate. 

 

The image appears in the cross-section view. 

 

Use the drag (top-left corner) and re-size (lower-right corner) handles (blue rectangles) to 

position and scale the image. 
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9.5 BOREHOLES 

Enter borehole data interactively, or import borehole data from a comma or tab-separated text 

file. Groundhog cannot read spreadsheet formats directly, but the data can be entered into a 

spreadsheet and then saved out as text files. The ordering and naming of the data columns is 

flexible, an example format is shown below. Note that each row in this table is one interval of 

data, and a complete borehole log is lilely to take up several rows. 

 

ID X Y START Z LITHOLOGY TOP BASE 

BH_1 245698 105669 27.8 SAND 0 12.5 

BH_1 245698 105669 27.8 SILT 12.5 27.2 

BH_2 250558 115557 35.4 MADE 
GROUND 

0 19.4 

BH_2 250558 115557 35.4 CLAY 19.4 22.9 

 

Typically, the records entered into this spreadsheet are input from driller’s logs. Good examples 

of these can be found on the BGS Geology of Britain Viewer (web search for “Geology of 

Britain Viewer”) using the Borehole Scans theme. The map interface allows the records to be 

explored and hyperlinks from each location allow access to the scanned driller’s log. 

 

 

 

This is 1 

Borehole

ee 

1 Borehole 

Interval 
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Example scanned driller’s log. 

 

 

 Entering Borehole Data Interactively 

Click the Create a new borehole object link in the Welcome screen. 

 

Enter as much information as you wish into the collar data dialog, such as a name, [X,Y] 

position, start elevation, etc. If you do not have this information, just click OK to accept the 

defaults (you can edit these values at any time later on). 
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Select a template. Groundhog includes a basic template, but you can also design your own – 

refer to the log template section of the main user manual for details. 

 

The borehole log will be displayed and can be worked on. By default the log for the borehole 

will be allocated a 1m interval of SAND as an initial state, which can then be edited, using the 

right-click options, as required. These log editing options are also available by right-clicking 

on the log intervals in the main object tree. 
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Build up the log by adding intervals by depth. 
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 Importing Borehole Data From a File 

Import the borehole data from the delimited text file. 

 

 

Browse for data file(s). If collar data and log data are in separate files, browse for the collar file 

in the left-hand panel, and browse for the log file in the right-hand panel. If all data is in a 

single file, pick the same file in both panels. Once loaded, use the drop-down controls to map 

each field to the appropriate data column. 



OR/15/046; Final 1.1  Last modified: 2017/07/17 09:31 

 161 

 

 View boreholes in map. 

 

Hold shift key down, and mouse over borehole locations to preview any available log(s). 

 

 View borehole log 

Right-click on a borehole object in the tree or in the map > View In Log Window. If the 

borehole has a geology log it will be displayed in the selected template, but if not you will be 

prompted to create a new one which can then be edited interactively. 

R-Click 
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9.6 GRID LAYERS 

Elevation data is used to generate terrain profiles for cross-section drawing, and also to display 

reference layers such as a groundwater level. Elevation grids can be imported from ESRI grid 

files in their non-proprietary ASCII form. 

https://en.wikipedia.org/wiki/Esri_grid 

These files can be prepared using a GIS, for example using ESRI ArcToolbox Raster to ASCII 

function. 

 

 

Choose the file that is required.  Upon import, Groundhog will automatically converted the 

ASCII file into proprietary Groundhog binary format to enable more efficient querying. Please 

note this conversion may take a few moments. Imported grids appear in the tree under Grid 

Coverages and Modelled Objects. 

https://en.wikipedia.org/wiki/Esri_grid
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If the grid data is a digital elevation or terrain model to be used for generating cross-section 

profiles you must set it as the Model Cap. This can be done via Right-click > Set as ‘Model 

Cap’ on the grid object in the tree, or by selecting it in the Capping Layer drop-down in the 

main Settings tab.  

 

Or… 

 

The first time a cross-section is displayed, if it does not have a topographic profile, one will be 

auto-generated from the Model Cap layer. If no Model Cap layer is available you will be 

prompted to generate a fixed elevation topographic profile which can be edited to shape as 

desired. 
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Set the desired elevation, in this case 100m AOD (0 being sea-level). 

 

Editing the topographic profile. 

 

Any cross-section with existing terrain profiles that need replacing (for example if an updated 

topographic grid is made available) can also be updated manually by clicking on settings and 

update profile within the cross-section view. 
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9.7 DISPLAY A REFERENCE SURFACE WITHIN A CROSS-SECTION 

A reference surface, such as a groundwater level, can be imported as an ASCII file, as described 

above.  It will then be available to display within any section within its boundaries, by clicking 

on the Grids tab within the Cross-section window settings area. Check it on to display, and use 

Right-Click > Settings to set a colour for the line in the cross-section. 

 

 

9.8 DRAW 

Use Groundhog to draw geological cross-sections. You can construct a new cross-section from 

the welcome screen, or in a map window. 

A cross-section constructed from the welcome screen will not be spatially referenced, but is a 

quick way to draw a cross-section where the map location is unimportant. Click the Create a 

new cross-section object link. 

Groundwater level 
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Enter a name 

 

Specify the length (meters) of the new cross-section 

 

The blank cross-section will be displayed with a ground level at 0m which can be edited. 
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To create a new cross-section in a map window, click Create Cross-Section. Enter a name. 

Single click in map to add points to the section, single click on boreholes to include them in 

the section. 

 

 

Click Finish Cross-Section to complete the cross-section and to exit cross-section building 

mode. 

 

 

Right-click on line of section in map > View Cross-Section. Section opens in new section 

window. DTM profile is loaded automatically (slight delay). Navigate as-per map (left button 

to pan, mouse wheel to zoom). 

Click on borehole to include in 

section 
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As can be seen above, some borehole start heights are either missing or incorrect.  There are a 

few options here.  Firstly, click on the Borehole options button in the settings tab: 

 

 

Choose the appropriate option for your boreholes. 
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Alternatively, edit the borehole height from the object tree. 

 

 

 

Edit borehole details. 

R-Click 
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9.9 DRAWING GEOLOGICAL LINES 

You can draw geological lines in map and cross-section. First, decide what names these lines 

will have, for example layer/formation names or simple lithological names. Layer names are 

stored in the rock code library, and Groundhog ships with a pre-loaded list of basic lithological 

codes, but you can also add your own. BGS layer names are typically shortened codes, rather 

than full descriptive names. You can also set colours for the layers as Red/Green/Blue values 

in the range 0-255. Here are examples from the simple lithological scheme used in various 

examples within this manual.  

Any drawing codes that you want to use which do not already exist in the rock code library  

can be added using the Add Code button in the Codes panel. 

 

Add code dialog allows entry of code, description, and selection of a colour. 

 

 

Digitizing tools and related settings are in the toolbar of cross-section and map windows. 
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By default, the active drawing code is a generic attribute of “SHAPE”. So, before drawing 

geological linework, choose a rock code for drawing with by clicking on its entry in the Codes 

panel. This sets it as the active drawing code in all windows. 

 

Choose a drawing tool button. Pen = left click and hold, drag to draw, release button to finish 

line. Digitizer = single click to add points, double-click to finish line. 

Draw a line into a map or cross-section. When you have finished drawing the line, make sure 

to click the drawing tool button again to de-activate the drawing mode. 

Vertical 

Exaggeration 

Pen Digitizer 

Currently active 

drawing code 
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In cross-section, lines can be snapped together to create a colour-flooded graphic. Single-click 

on line to make active, drag end nodes to edge of section and up to terrain profile to “snap”. 

Section colours up. 

 

 

 

9.10 SAVE PROJECT 

Click save button and enter a file name. Groundhog projects have file extension .gop. 
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10  Appendix B – System Configuration 

This appendix contains detailed information about certain system configuration options. 

10.1 PROXY SETTINGS 

Certain Groundhog functions may rely on an internet connection, for example to access web 

map services. However, local network configurations, such as those controlled by your 

organizations IT policy, can block this access. Often in these cases a proxy server is used as a 

go-between for security purposes. You can configure Groundhog to use your local network 

proxy server settings. Try this if you experience any problems accessing online data services 

from within Groundhog, such as web maps not appearing. 

To set proxy settings for the duration of your Groundhog session, choose Session > Proxy 

Settings. Enter the proxy server configuration for your local network (ask your local IT 

administrator if you do not know what these settings should be for your network), or check Use 

default system settings for Groundhog to attempt to detect the settings automatically. 

 

To set proxy settings permanently currently requires a manual configuration within the 

software install directory (Usually C:\Program Files\BGS Groundhog Desktop\). Create a file 

in here named ProxySettings.txt with the settings specified in the following format (tab-

separated, two lines). 

PROXY_HOST 123.45.67.89 

PROXY_PORT 1234 

After making any change to the proxy settings make sure to re-start Groundhog for the changes 

to take effect. 

 


